Note: Before using this information and the product it supports, read the information in “Notices” on page vii.
# Contents

## Notices

- Notices .......................................................... vii
- Trademarks ...................................................... viii

## Preface

- Preface .................................................................. ix
- The team that wrote this Redpaper ......................... ix
- Become a published author .................................... x
- Comments welcome ............................................. x

## Chapter 1. Introduction to Smart Upgrade

- Chapter 1. Introduction to Smart Upgrade .................. 1
  - 1.1 Overview of Smart Upgrade .............................. 2
  - 1.2 Overview of client installations ......................... 3
    - 1.2.1 Some of Smart Upgrade’s new features .......... 4
  - 1.3 Goals of this Redpaper ................................... 5
    - 1.3.1 Example scenario - ITSO Bank .................... 5

## Chapter 2. Planning to upgrade the Notes clients

- Chapter 2. Planning to upgrade the Notes clients ......... 7
  - 2.1 Overview .................................................. 8
  - 2.2 Current client environment ................................ 8
    - 2.2.1 Client installations ................................. 8
    - 2.2.2 Physical location of clients ....................... 9
    - 2.2.3 ITSO Bank scenario ................................ 9
  - 2.3 Which client installation kits will be used? .......... 10
  - 2.4 Domino environment and network configuration considerations. 10
    - 2.4.1 Network ............................................... 11
    - 2.4.2 Servers ............................................... 11
  - 2.5 Preparing your team for the upgrade ................. 12
  - 2.6 Deploying Smart Upgrade ............................... 12
  - 2.7 Confirming successful upgrade of clients ............ 12

## Chapter 3. Creating the Smart Upgrade database

- Chapter 3. Creating the Smart Upgrade database .......... 15
  - 3.1 Creating the Smart Upgrade database ................ 16
  - 3.2 Deployment of the Smart Upgrade database ......... 17
    - 3.2.1 Centralized deployment topology ................ 17
    - 3.2.2 Distributed deployment topology ............... 18
    - 3.2.3 Example: Deploying the Smart Upgrade database at ITSO Bank .... 18
  - 3.3 Defining the Smart Upgrade database in the server’s Configuration document ...... 19

## Chapter 4. The Smart Upgrade kit document

- Chapter 4. The Smart Upgrade kit document ............. 23
  - 4.1 Planning to create the Smart Upgrade kit documents .......... 24
  - 4.2 Definition of the Smart Upgrade document fields .... 25
    - 4.2.1 The Basics tab .................................... 25
    - 4.2.2 The Administration tab ......................... 27
  - 4.3 Smart Upgrade pattern matching ....................... 28
  - 4.4 Using optional arguments when running Smart Upgrade .... 29
    - 4.4.1 Creating a silent installation on a shared network drive ....... 30
    - 4.4.2 Creating a silent installation for an attached installation kit .... 31
    - 4.4.3 Using Transform files in Smart Upgrade .......... 31
  - 4.5 Creating Smart Upgrade Kit documents ............... 32
    - 4.5.1 ITSO Bank Smart Upgrade documents ............ 33

© Copyright IBM Corp. 2006. All rights reserved.
Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to:
IBM Director of Licensing, IBM Corporation, North Castle Drive Armonk, NY 10504-1785 U.S.A.

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:
This information contains sample application programs in source language, which illustrates programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. You may copy, modify, and distribute these sample programs in any form without payment to IBM for the purposes of developing, using, marketing, or distributing application programs conforming to IBM’s application programming interfaces.
Trademarks

The following terms are trademarks of the International Business Machines Corporation in the United States, other countries, or both:

- developerWorks®
- Domino®
- IBM®
- Lotus Notes®
- Lotus®
- Notes®
- Passport Advantage®
- Redbooks™
- Redbooks (logo) ™
- Workplace™

The following terms are trademarks of other companies:

Microsoft, Windows, Win32, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.

Other company, product, or service names may be trademarks or service marks of others.
Preface

This IBM® Redpaper provides the knowledge required for organizations to upgrade to Lotus® Notes® 7 using Smart Upgrade to automate the process. All organizations can benefit from the new features of Lotus Notes 7, and Smart Upgrade helps reduce the time, cost, and effort involved in upgrading clients.

Smart Upgrade, introduced in Lotus Notes and Domino® 6, enables organizations to upgrade Lotus Notes clients easily, without having to visit each workstation or configure each installation process. The new features of Smart Upgrade 7 provide even greater administrative control and flexibility over the upgrade process, by providing integration with proven Lotus Notes and Domino technologies: Policies to ensure that upgrades are completed in a timely manner, clustering for failover, and mail-in database tracking reports to manage, track, and troubleshoot the upgrade process.

This Redpaper provides practical advice for implementing Smart Upgrade to help your organization optimize and simplify your upgrade to Lotus Notes 7.

The team that wrote this Redpaper

This Redpaper was produced by a team of specialists from around the world working at the International Technical Support Organization, Cambridge Center.

Philip Monson is a Project Leader at the ITSO Lotus Center in Cambridge, Massachusetts. Phil has been with Lotus/IBM for 16 years, joining the company when the early versions of Notes were rolled out for internal use. He has served in management, technical, and consulting roles in the IT, Sales, and Development organizations.

Julie Castle has worked in the IT industry for 15 years in a range of consulting, project, and management roles in the software arena. Julie has been involved in many large Lotus Notes and Domino infrastructure planning and deployment projects in both a technical and project management capacity. She has worked for IBM Software Group in Melbourne, Australia, for six years, the past four of which have been as a Premium Support Manager (PSM) working on IBM Premium Support Program accounts. Julie has a degree in Politics and Literature, and a Graduate Diploma in Computer Science.

Robert Harrison is Senior Software Engineer with the Workplace™ Portal and Collaboration Software Division of the IBM Software Group. He has been a Software Engineer on the Notes Client Team for the past six years and is the Product Area Expert of the Notes Client Installation Team. He is an IBM Certified System Administrator for Lotus Notes and Domino 6/6.5 and 7. Bob has a Bachelors degree from University of Massachusetts - Lowell in Sociology with a minor in Computer Science and Certificates from Boston University in Computer Science.

Arnaz Rustomji has been with the IBM Lotus Support team for the past four years. She is currently a Software Engineer supporting PSP customers on the Notes Client team. She is the primary for the Notes Client Crash team, and is a member of Client Install, Roaming Users, and Workstation Mail teams. Arnaz received her B.S. in Computer Science & Engineering from the University of Connecticut at Storrs in 2002 and her M.S. in Computer Science from Boston University in 2006.
Thanks to the following people for their contributions to this project:

John Paganetti, Senior Engineer
Jeff Mitchell, Advisory Software Engineer
Robert Carter, Domino Server Team Manager
Robert Ingram, Domino Product Manager
Jane L. Wilson, Knowledge System Architect
IBM Software Group, Lotus

Become a published author

Join us for a two- to six-week residency program! Help write an IBM Redbook dealing with specific products or solutions, while getting hands-on experience with leading-edge technologies. You’ll team with IBM technical professionals, Business Partners, and/or customers.

Your efforts will help increase product acceptance and customer satisfaction. As a bonus, you’ll develop a network of contacts in IBM development labs, and increase your productivity and marketability.

Find out more about the residency program, browse the residency index, and apply online at: ibm.com/redbooks/residencies.html

Comments welcome

Your comments are important to us!

We want our papers to be as helpful as possible. Send us your comments about this Redpaper or other Redbooks™ in one of the following ways:

- Use the online Contact us review redbook form found at:
  ibm.com/redbooks
- Send your comments in an e-mail to:
  redbook@us.ibm.com
- Mail your comments to:
  IBM Corporation, International Technical Support Organization
  Dept. HYTD  Mail Station P099
  2455 South Road
  Poughkeepsie, NY 12601-5400
Introduction to Smart Upgrade

Lotus Notes Smart Upgrade was developed in Lotus Notes and Domino 6 to assist administrators in upgrading the Notes client efficiently and easily. This Redpaper is designed to introduce the Smart Upgrade feature and help administrators configure it in their environment. We will discuss best practices for setting up Smart Upgrade to upgrade all clients with minimal client interaction.

It is important to upgrade to the latest version of Lotus Notes and Domino because it can help your organization receive a high return on investment, potentially lower your cost of ownership, and help improve user productivity and business responsiveness.

In this chapter the following topics are discussed:
- Overview of Smart Upgrade
- Overview of client installations
- Goals of this Redpaper
- Example scenario - ITSO Bank
1.1 Overview of Smart Upgrade

Beginning in Lotus Notes version 6, Smart Upgrade enables administrators to push out a Notes client upgrade with ease to an entire company or selected individuals. The introduction of Smart Upgrade prevents administrators and support staff from needing to visit each desktop, which reduces the dependency on third-party tools and the total costs of upgrading.

Restriction: Lotus Notes Smart Upgrade can only be used with Notes Client V6.0 and later.

Kits
When using Smart Upgrade, you can push out a full kit, an upgrade kit, or a patch kit. As an administrator it is important to know the differences between the available kits.

Tip: Refer to “Which kit do I use?” on page 67 for details about the available kits.

You may download the kit from the IBM developerWorks® Web site, or from Passport Advantage®. For further information, see “Where to obtain the Lotus Notes Installation Packages” on page 70.

Smart Upgrade database
After downloading the kit, administrators should create a Smart Upgrade database on the Domino servers. A kit document should then be created within this database to define the location of the kit files that will be pushed out. The downloaded kit can be saved on a shared network drive that users have access to, as an attachment in the kit document, or both.

The Domino server recognizes that a Smart Upgrade database exists by pointing to the database via a doclink in the Server Configuration Settings document. After Smart Upgrade is configured on the server, the Notes client recognizes that a newer release is available with a prompt upon authentication when logging in to the Home/mail server.

Chapter 3, “Creating the Smart Upgrade database” on page 15 has instructions for setting up the Smart Upgrade database. Instructions for setting up the Smart Upgrade kit documents can be found in Chapter 4, “The Smart Upgrade kit document” on page 23.

Advanced configurations
Policy documents and Desktop Settings documents help manage updates and allow tracking for administrators to determine if users have successfully upgraded or are experiencing problems. If there are instances where Smart Upgrade fails, administrators can use the information in a generated report to assist in determining the problem without having to visit the user's desktop. Administrators may also use these reports to diagnose whether there is a repeating problem on multiple clients that could be related to the configuration of the Smart Upgrade database containing the kit information.

Using a desktop policy in deploying Smart Upgrade is optional and not required for Smart Upgrade. In addition to the tracking reports described above, it offers more features including an upgrade deadline, and the “remind me every hour” feature after the upgrade deadline has passed. In addition, it enables administrators to control the versions of the Notes clients on all workstations.

For more advanced configurations with the Smart Upgrade process, reference Chapter 5, “Advanced configuration” on page 37.
1.2 Overview of client installations

Rolling out a new release of Notes clients is usually the most time-consuming effort of the upgrade process. Lotus has invested and continues to invest in this effort to assist administrators managing the client upgrade. Prior to Notes 6.0, administrators had a choice to upgrade clients remotely with the Upgrade-by-mail feature, manually via an administrative installation at the users client machine, or by using third-party installation methods.

The Upgrade-by-mail feature enables the Notes client and templates to upgrade from versions 4.6 and 5.x. However, the upgrade-by-mail feature did not force users to upgrade, and was harder to manage for administrators.

Smart Upgrade was introduced in Lotus Notes and Domino 6 to enable administrators to upgrade and deploy Lotus Notes clients via installation kits remotely. The Smart Upgrade feature enables administrators to easily upgrade clients with different localizations and different setups simply by configuring multiple kit documents. The Notes client periodically checks whether a matching kit document is found, and if so will prompt for upgrade.

Table 1-1 compares the advantages and disadvantages of Upgrade-by-mail, Smart Upgrade, and Administrative installation.

<table>
<thead>
<tr>
<th>Option</th>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
</table>
| Administrative Installation | ▶ Upgrade from any prior release  
▶ Can upgrade on a workstation where users have limited rights to the operating system (OS) | ▶ Time consuming  
▶ Administrators need to visit each workstation, or rely on users to perform installation and configuration |
| Upgrade-by-mail       | ▶ Upgrades Notes clients from 4.x, 5.x, and 6.x to latest releases          | ▶ Harder to manage - needs more administrative work  
▶ No error tracking  
▶ Does not force the user to upgrade; users might ignore the e-mail |
| Smart Upgrade         | ▶ Automatically performs multiple upgrades for users with different setups without user intervention  
▶ Periodically prompts the user to upgrade  
▶ Forces the user to upgrade if the grace period has expired if the policy is set  
▶ Enables user to control when the Notes client upgrade occurs | ▶ Can be used only with Notes 6.0 and greater  
▶ Cannot be used on workstations where users have limited rights on the OS |

Note: See Appendix C, “Sneak preview: Smart Upgrade “Run As Admin” utility” on page 91, for a preview of the new feature which allows Smart Upgrade to upgrade users with limited OS rights.
1.2.1 Some of Smart Upgrade’s new features

Smart Upgrade has been enhanced since it was first introduced in Notes 6.0, and the enhancements continue. This section describes some of the new features that have been introduced in specific releases of Domino and the Notes client.

**Smart Upgrade server cluster failover**
Beginning with Notes client 6.5.1, Smart Upgrade server failover is available when clustered servers are configured. When the Notes client user logs on, the user's home server Configuration document (in the Domino Directory) is checked to access the link to the Smart Upgrade database. If the server containing the Smart Upgrade database is not available, Smart Upgrade will still work if there is a replica of the Smart Upgrade database on a cluster-member server. This is particularly useful if the user’s Home/mail server is unavailable for an extended period.

**Smart Upgrade from shared drive path to attachment**
Beginning in Domino and Notes Client 6.5.2, the Smart Upgrade Kit documents can be set to include both a shared network path pointing to the installation files and an attached installation kit. The Smart Upgrade process checks whether a “Full Path Kit” is available in the Smart Upgrade Kit document. If the Full Path Kit is available, it is used; if it is not available, the attached kit is used.

**Background thread initiating the download**
Beginning in Notes Client 6.5.3, a background thread will download the kit attachment for the Smart Upgrade. This will prevent the Notes client machine from being tied up while the executable is brought down locally.

**Smart Upgrade Tracking reports**
Beginning in Notes client 6.5.3, the Smart Upgrade Tracking Reports database is a repository for storing Smart Upgrade Tracking reports that contain detailed information about the status of attempts to run Smart Upgrade on Notes clients. This is done by creating or modifying an existing Desktop Settings document and a mail-in database. If there are instances where Smart Upgrade fails, it is possible to determine the problem without having to visit the user's desktop. The Tracking reports can also enable administrators to determine whether Smart Upgrade successfully upgraded the Clients, and of any user cancellations.

**Smart Upgrade Governor**
The Smart Upgrade Governor can be used to control the number of concurrent Smart Upgrade downloads. This capability was introduced concurrently in version 6.0.5 and 6.5.4 (commonly written as “6.0.5/6.5.4”). The Governor allows only the concurrent downloads of Smart Upgrades kits up to the Maximum Concurrent Downloads value specified in the Server Configuration document. If another request comes in to begin a Smart Upgrade and the Domino Server is already at its maximum, the next upgrade attempt will be delayed one hour. This enables administrators to control the amount of traffic throughout their network.

**Smart Upgrade database intelligent locator**
Beginning in Domino 6.5.4, the Domino Server will use the closest Smart Upgrade database replica when building its in memory cache. With this new feature, administrators no longer have to explicitly define the Smart Upgrade database links in the Domino Server Configuration document. The Notes client will then use the closest Smart Upgrade database when downloading the attached kit.
All clients versus Notes client recognition
Beginning in Notes Client 6.5.5, Smart Upgrade kit has an additional recognition feature. It will automatically determine whether to install a Notes Client Only kit or an All Clients kit for each install by checking the InstallType= setting in the client NOTES.INI file. Smart Upgrade recognition makes it easy to upgrade users who have more than one computer with different client install types, that is, a user can have one computer running only Notes client and another computer running all clients. You can use Smart Upgrade to easily upgrade both computers for this user.

Restriction: Pre-Notes 6.5.5 clients can have only one Smart Upgrade kit per user, per source version. If you attempt to configure multiple source kits (that is, Notes Client Only and All Clients for a release of Domino that is pre-Domino 6.5.5), an error message appears indicating that duplicate kits have been found for that user in the Smart Upgrade database, and Smart Upgrade will fail.

1.3 Goals of this Redpaper
The goals of this Redpaper are to:

- Introduce Lotus Notes Smart Upgrade: concepts, terms, features, benefits, and requirements.
- Describe the planning tasks required to ensure a smooth Smart Upgrade deployment for the organization.
- Understand the administrative tasks required to implement Smart Upgrade.
- Help administrators to validate the upgrade and troubleshoot any issues that might be encountered.

1.3.1 Example scenario - ITSO Bank
For better illustration throughout this Redpaper, we will be using a fictitious organization named ITSO Bank. Our administrator, Bob Harrison, has three servers to administer, located in Boston, Los Angeles (LA), and Paris as depicted in Figure 1-1. The Boston and LA servers are clustered.

Figure 1-1 ITSO Bank Domino environment
Bob has recently upgraded his servers to Domino 7.0.1. His next project is to upgrade his entire user base in Boston, Los Angeles, and Paris to the new release of the Notes client version 7.0.1. Multiple versions of the Notes client are present throughout his organization ranging from 6.0 to 6.5.5. The Notes English client is installed in the United States, and the Notes French client is installed in France. Because of the simplicity of Smart Upgrade, Bob has decided to use it to upgrade all clients from 6.x to 7.0.1. Throughout this Redpaper, we will observe as Bob implements Smart Upgrade in his Domino environment.
Planning to upgrade the Notes clients

This chapter discusses the planning steps that are recommended prior to upgrading the Notes clients. It takes into account the present environment and what types of upgrade can be handled by the Smart Upgrade feature.

In this chapter, the following topics are discussed:

- Current client environment
- Which client installation kits will be used?
- Domino environment and network configuration considerations
- Preparing your team for the upgrade
- Deploying Smart Upgrade
- Confirming successful upgrade of clients

While discussing these topics, we will help Bob, the ITSO Bank administrator, plan the Client upgrades in his environment.
2.1 Overview

When you start an upgrade project, it is important for the project team to have detailed upgrade plans. Before starting an upgrade project, the team should consider:

- Current client environment
- Which client installation kits will be used?
- Domino environment and network configuration considerations

These considerations help administrators determine how to set up Smart Upgrade depending on their environment. For example, different Smart Upgrade Kit documents must be created for specific releases and different language versions of the client. The environment in the organization also could affect how the installation files are saved. This chapter explains some of the considerations for planning the Smart Upgrade.

2.2 Current client environment

This section helps administrators analyze their entire Notes client environment to determine how to optimally configure Smart Upgrade. The Notes client version and language (localization) should be considered, along with the physical location of the Notes clients and how they connect to their Domino mail servers. Understanding the user base, how they connect, and what versions of the client they are running is important when deploying Smart Upgrade.

2.2.1 Client installations

When considering the Notes clients that are currently installed on user workstations, administrators must take into account which users will require the upgrade, the versions, languages (localization), and the type of installation.

**Which users require the upgrade?**

Administrators must take into consideration who needs to be upgraded in the environment. If administrators want to upgrade only a group of users instead of everyone in the environment, it can be done using the Allowed Users and Servers field on the Administration tab of the Smart Upgrade document, or by using Domino Policies with a Desktop Settings document.

**Important:** When creating the Smart Upgrade Kit document, the default value for the Allowed Users and Servers field is set to All users. Thus after the Smart Upgrade database has been configured, all users with matching Notes clients will be prompted to upgrade, unless additional controls are applied. Notes administrators have the option to disable this field initially.

**Versions**

When beginning to plan the upgrade of the Notes clients, we must look at what versions of the Notes clients are installed for those who need to be upgraded. One way to determine the versions in your environment is through the Client Build information located in the Person Documents through your Administrator client. For more information about how to track the versions through the Domino Directory, refer to 5.3.3, “Checking the Notes client version in the Domino Directory” on page 48.
Localization
If you have users in multiple regions of the world, their workstations are probably running different languages of the Notes client. Make a list of the client languages that are deployed in your environment. Based on this information, different kit documents will have to be created in the Smart Upgrade database. Each kit document will point to a different set of installation files for each language-specific client. Figure 2-1 on page 10 shows the Smart Upgrade database created in our scenario.

Type of installation: Notes Client only versus All Clients
When looking at the client installations, it is important to consider whether the installation type is the Notes Client only or the All Clients (“Notes client, Admin client, Designer”) installation. Prior to Notes Client 6.5.5, Smart Upgrade was unable to differentiate between the Notes Client only and the All Clients installation. If you have pre-6.5.5 clients, a separate Smart Upgrade Kit document will be required for the Notes Client only and the All Clients upgrades.

For further information, refer to “Version-specific requirements” on page 68.

2.2.2 Physical location of clients
When planning a Notes client upgrade, it is important to decide where users will obtain the installation files. This will depend on what network the users are using: the company LAN, at home through a Virtual Private Network (VPN), by dialup, or broadband. The Smart Upgrade configuration enables administrators to choose to save the installation files as an attachment in the Smart Upgrade Kit document, on a shared network drive, or both.

Restriction: The option to supply both a shared network location and an attached kit requires both the Domino server and the Notes client to be at Version 6.5.2 or later.

The ability to save the installation files gives administrators more options in case users are working in a remote location through a slow network connection, or for users with limited access to file servers.

If the clients are connected to the Domino server via a slow network connection, this will affect the Smart Upgrade download process. For such users, provide information prior to the upgrade to give them an estimate of the time that will be required for the download process and what they should expect to see while it is in progress. For further information about what users will see during the Smart Upgrade download process, refer to 6.3.1, “The Smart Upgrade prompt” on page 60.

Tip: Administrators can add messages for Notes client users in the Basics tab of the Smart Upgrade Kit document.

2.2.3 ITSO Bank scenario
In our scenario with the ITSO Bank organization, Notes client versions range from 6.0 to 6.5.5. Our administrator, Bob, is required to upgrade all of the ITSO Bank Notes clients. Users in the United States are running the English version of the Notes client, and users in Paris are running French language clients. Because multiple 6.x versions and languages are installed, Bob must create multiple kit documents to upgrade all of his users to the Notes 7.0.1 client.

Figure 2-1 on page 10 shows the Smart Upgrade Database that was created on the Paris/ITSObank server. Bob has created separate kit documents on this server for the pre-6.5.5 French Notes clients, and the 6.5.5 French Notes clients.
Throughout this Redpaper, we will walk through the ITSO Bank Smart Upgrade setup designed by Bob to optimize his upgrade to Notes 7.0.1.

2.3 Which client installation kits will be used?

It is important to plan which release of the Notes client will be deployed during the upgrade. Depending on which version is currently deployed throughout the organization, and the required upgrade version, different kits exist for different purposes. Both kits and hotfixes can be deployed via Smart Upgrade.

Notes client installation kits
Multiple installation kits exist for use with Smart Upgrade. These are available on the IBM Support Downloads site. For details about where to download the available kits, refer to “Where to obtain the Lotus Notes Installation Packages” on page 70.

- The Notes client full installation kit enables you to upgrade any client to a specific version. For example, it can upgrade any release such as 6.0 to 7.0.1.
- The Upgrade kit is used to upgrade from any point release to another within its codestream, such as any release of 6.5.x to 6.5.5.
- The Patch kit is used to upgrade from and to a specific point release. For example, a specific patch kit is available to upgrade the client from 7.0 to 7.0.1.

For more about the differences between the available kits, refer to Table A-1 on page 67.

Hotfixes
There will be times when a critical hotfix or a Cumulative Client Hotfix (CCH) has been released, and administrators will need to deploy the fix pack to all of the Notes clients. Smart Upgrade can be used to deploy client hotfixes for all of your users. For more information about using a hotfix in the Smart Upgrade Kit document, refer to “Using a Cumulative Client Hotfix with Smart Upgrade” on page 72.

2.4 Domino environment and network configuration considerations

Smart Upgrade enables administrators to configure the feature in line with the Domino environment, network configurations, and user base.

The Smart Upgrade database can exist on one or several servers. Planning for the location and replication of the Smart Upgrade database should include the number of users to upgrade, the location of the clients and servers, and the network bandwidth.
2.4.1 Network

Network topology and bandwidth are important considerations for deploying Smart Upgrade. A Smart Upgrade kit can be configured to have the installation files on a shared network drive, attached in the kit document, or both. If the files are on the network, users must have access to this shared location. Ample bandwidth is required for the planned number of concurrent Smart Upgrade downloads to occur.

**Tip:** If the network bandwidth could be a problem, the recommendation is to enable the Smart Upgrade Governor to limit the number of concurrent downloads. For more information about enabling this, refer to 5.4, “Limiting concurrent downloads with the Smart Upgrade Governor” on page 49.

Beginning with Notes client and Domino 6.5.2, administrators can specify both the shared network drive and an attached kit in the Smart Upgrade Kit document. The Smart Upgrade process first checks whether the installation files are available on the network drive. If so, the files are used from the network. If the files are not available, the attached package is used.

2.4.2 Servers

The Smart Upgrade Database must be created on at least one Domino server. The decision to create replicas on other servers in the domain depends on your organizational structure and the geographic locations and bandwidth of the Notes clients. It is important to know the configuration of your servers in this part of the planning process (for example, whether they are clustered, the physical locations, server versions, and so forth).

**Tip:** Although it is always recommended to upgrade your servers first, we realize that there are cases where the Notes clients are upgraded before the servers. It is important that the Smart Upgrade template for the Smart Upgrade database in use is at the same version as that of the latest Notes client currently in your environment.

For example in our scenario, assume that the Paris server was originally at Release 6.5.1. If there are Notes clients in the environment at 6.5.5, you must obtain and use the Smart Upgrade 6.5.5 template when creating the Smart Upgrade database, or replace the design of any existing Smart Upgrade databases.

Smart Upgrade may be deployed in many ways. Two examples are a centralized configuration and a distributed configuration:

- **Centralized deployment (sometimes known as a consolidated deployment):**
  
  All servers point to a single Smart Upgrade database that is defined on a single server. This setup uses a single "*- [Default]" (All Servers) Configuration document that contains the Smart Upgrade database doclink and Governor settings. While this is easy to administer, there is a single point of failure and all Smart Upgrade traffic will be directed to the one server.

- **Distributed deployment:**
  
  Requires replicas of the Smart Upgrade database on each of the Home/mail servers in the organization's domain. This setup requires a separate Configuration document for each Home/mail server, with the Smart Upgrade database link and Governor settings for the server in each one. This allows for a distributed load across several servers, and there is no single point of failure, but it does require additional configuration, replication, and disk space on the servers. Beginning in 6.5.4, the Smart Upgrade Database Intelligent Locator
enables the distributed deployment to be configured easily. For more about this, refer to “Smart Upgrade database intelligent locator” on page 4.

For more information about the different types of deployments, refer to 3.2, “Deployment of the Smart Upgrade database” on page 17.

**Tip:** Beginning with Domino Server and Notes Client 6.0.5/6.5.4, the Smart Upgrade Governor can be used to limit the number of concurrent downloads. The Governor can help limit the flow of traffic on the network and Domino Servers. For more about the Smart Upgrade Governor, see 5.4, “Limiting concurrent downloads with the Smart Upgrade Governor” on page 49.

### 2.5  Preparing your team for the upgrade

When deploying Smart Upgrade in your environment, administrators should inform their network administrators, other Domino administrators, and their Help Desk. This will prepare the team for any issues or user queries that might arise during the upgrade project.

It is also important to understand differences in the actual upgrade process for specific Notes client versions. For example, users running Notes 6.5.2 or earlier will not be able to use their Notes client while the Smart Upgrade download is occurring, as these earlier versions use a foreground process to download the installation files. For more about version-specific features of Smart Upgrade, see Table A-3 on page 68.

### 2.6  Deploying Smart Upgrade

It is important to test the Smart Upgrade process initially with a pilot group of users to determine whether your environment might have any specific issues. This will show administrators the entire Smart Upgrade process, and help decide whether any other modifications should be made before deploying it company-wide.

Full deployment should not be considered until the pilot process has proven successful.

See Chapter 3, “Creating the Smart Upgrade database” on page 15 and Chapter 4, “The Smart Upgrade kit document” on page 23 for specific information about deploying Smart Upgrade.

### 2.7  Confirming successful upgrade of clients

After Smart Upgrade has been configured and deployed, administrators have three options to monitor the success and failures of upgrading the clients:

- Smart Upgrade Tracking Reports
- Smart Upgrade logging in the Notes client
- Client build version in the Domino Directory

**Smart Upgrade Tracking Reports**

Beginning in Notes Client 6.5.3, administrators can view the status of their deployment without having to visit the users’ workstations. The Smart Upgrade Tracking Reports database is a repository for storing reports that contain detailed information about the status of all attempts to run Smart Upgrade on Notes clients in a domain. For further information
about the Smart Upgrade Tracking Reports, refer to 5.3.1, “The Smart Upgrade Tracking Reports database” on page 42.

**Smart Upgrade logging in the Notes client**
Beginning in Notes Clients 6.5.3, a directory exists for Smart Upgrade logging purposes. Located under the Lotus\Notes\Data\IBM_TECHNICAL_SUPPORT\SmartUpgrade directory, a new log file is created for each Smart Upgrade attempt. In addition, when Smart Upgrade Tracking has been enabled, these log files are attached to the reports for administrators to view. For more information about the logging in the Notes Client, refer to 5.3.2, “Smart Upgrade logging on the Notes client” on page 47.

**Client build version in the Domino Directory**
The Notes user Person Documents in the Domino Directory contain information about the Notes client version in use for each user in the organization. The Notes client version information can be viewed by the Domino Administrator to check the most recently installed version on the client. The fields containing the Notes client version information are stored on the Administration tab of each Person Document, in the Notes client machine section. For more information, refer to 5.3.3, “Checking the Notes client version in the Domino Directory” on page 48.
Creating the Smart Upgrade database

The Smart Upgrade database is the central location for the Smart Upgrade documents that control the Smart Upgrade process and store the upgrade kits or their location on a network drive. This chapter also discusses methods of deploying the database within an organization and configuring the Domino server to recognize the Smart Upgrade database. The database must reside on at least one server in the domain but, depending on your organization, multiple replicas or multiple Smart Upgrade databases may be used.

In this chapter, the following topics are discussed:

- Creating the Smart Upgrade database
- Deployment of the Smart Upgrade database
- Defining the Smart Upgrade database in the server's Configuration document
3.1 Creating the Smart Upgrade database

This section describes the Smart Upgrade database creation process. Following our scenario, Bob the Domino administrator will initially create one Smart Upgrade database on the hub server: Boston/ITSObank. He will then replicate this database to the other US server (LA/ITSObank) and create a separate Smart Upgrade database for the Paris/ITSObank server. Following that, Bob will configure the servers’ Configuration documents to include the database links to the Smart Upgrade databases.

To create a Smart Upgrade database:

1. In the Domino Administrator client, choose **File → Database → New**. Figure 3-1 shows the dialog that opens.

![Figure 3-1 Creation of the US Smart Upgrade database](image)

2. In the New Database dialog box, enter the server name and database title.

3. Enter a file name in the File Name field. If the database title is entered first, this field will be filled automatically using the first eight characters of the database title. The default file name can be changed.

4. Click **Template Server**, then choose the server on which the database will reside.

5. Select the **Show advanced templates** check box.

6. Select **Smart Upgrade Kits** from the box of template names, then click **OK**.

7. The default About this Database window is displayed. When it is closed, the main Smart Upgrade Kits view of the Smart Upgrade Database will be open, as shown in Figure 3-2.

![Figure 3-2 Default Smart Upgrade database view](image)

Bob has decided to create a second Smart Upgrade database on the Paris/ITSObank server. This database will contain the Smart Upgrade Kit documents for the French Lotus Notes
clients, and the database will not be replicated to the US. Figure 3-3 shows the creation of the Paris Smart Upgrade database.

Figure 3-3 Creation of the Paris Smart Upgrade database

**Important:** Each Release 6.0 or greater Domino Server creates an in-memory cache from all of the kit information that is configured in the Smart Upgrade database. Remember, the database may be local or remote, depending on the Smart Upgrade database link in the effective server configuration settings for each Domino Server.

In Release 6.0, the Smart Upgrade cache is updated hourly, so changes you make to the Smart Upgrade database might not take effect immediately;

- Type `sucache refresh` at the Domino server console to force Smart Upgrade to update its cache and use the latest configuration settings.

### 3.2 Deployment of the Smart Upgrade database

The Smart Upgrade database must be created on at least one Domino server. The decision to create replicas on other servers in the domain depends on your organizational structure and the geographic locations of the Notes clients. Of the many deployment topologies that may be used for the Smart Upgrade database, two are reviewed here:

- Centralized deployment topology
- Distributed deployment topology

#### 3.2.1 Centralized deployment topology

In a centralized deployment topology, there is only one Smart Upgrade database on a specific server. The Smart Upgrade database on this Domino server is referenced in a “** - [Default]” (All Servers) Configuration document in the Domino Directory. Prior to Domino 6.5.4 and the introduction of the Smart Upgrade Database Intelligent Locator, the Notes client looks at the Smart Upgrade database on the one server for the Upgrade Kit document that provides the Smart Upgrade parameters and installation kit locations. This deployment method is used most often for smaller organizations that have one central location.
3.2.2 Distributed deployment topology

In a distributed deployment topology, the Smart Upgrade database is replicated to multiple Domino servers in the organization, or there are multiple Smart Upgrade databases. Each of the individual Domino server Configuration documents contains a database link to the Smart Upgrade database on that server. When the Smart Upgrade process occurs on the Notes client, it looks to the replica of the Smart Upgrade database on their Home/mail server as specified in the Location document on their Notes client. This deployment method is most often used in larger organizations that have different geographical locations. The Notes client is directed to the Smart Upgrade database and Upgrade Kit document that provides the Smart Upgrade parameters and installation kit locations on their local mail server rather than being directed to a server that is in a different geographic location.

The chosen deployment topology depends on the number of users requiring upgrade, the location of their Notes clients, and the bandwidth of the network. Table 3-1 shows the advantages of each deployment method.

Table 3-1 Deployment Options for Smart Upgrade

<table>
<thead>
<tr>
<th>Deployment method</th>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Centralized deployment</td>
<td>Easy to administer:</td>
<td>Single point of failure. All network traffic will be pointed to a single server</td>
</tr>
<tr>
<td></td>
<td>▶ All servers point to a single Smart Upgrade database</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▶ Only one Configuration document is required</td>
<td></td>
</tr>
<tr>
<td>Distributed deployment</td>
<td>▶ Distributed upgrade across several servers/clusters</td>
<td>▶ More difficult to manage:</td>
</tr>
<tr>
<td></td>
<td>▶ No single point of failure</td>
<td>▶ Configuration documents are required for each pre-6.5.4 server</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▶ Replication considerations:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▶ bandwidth between servers, disk space usage</td>
</tr>
<tr>
<td></td>
<td></td>
<td>on servers required to store the database replicas</td>
</tr>
</tbody>
</table>

3.2.3 Example: Deploying the Smart Upgrade database at ITSO Bank

In our scenario, the offices of the ITSO Bank are located in two U.S. cities, Boston and Los Angeles (LA), and there is an international office in Paris, France. It was decided that a distributed deployment topology should be used. This will increase performance and reduce bandwidth consumption, because Notes clients will be using installation kits located on a Server that is in their own geographic location instead of one located over wide area network (WAN).

Our administrator, Bob, has decided to use a separate Smart Upgrade database for the Paris server so that the French client installation kits will not be replicated to the U.S. servers and the English client installation kits will not be replicate to the Paris server. This will save disk space and reduce bandwidth usage between the servers. Bob will still need to create a replica of the Smart Upgrade database on each of the servers in the United States. (For information about creating database replicas in the domain, refer to the Lotus Domino Administrator 7 Help database.)

Because the ITSO Bank is using Domino 7 servers, Smart Upgrade will make use of the Smart Upgrade Database Intelligent Locator introduced in Domino 6.5.4. The Domino Server will use the closest Smart Upgrade database replica when building its in memory cache. Even though there is one Configuration document for the U.S. servers group, and the Smart
Upgrade Database link in that document points to the Smart Upgrade Database on the Boston/ITSObank server because the database has been replicated to the LA/ITSObank server, users on the LA server will use the Smart Upgrade Database located on their home server (LA/ITSObank) and not the Boston/ITSObank server.

### 3.3 Defining the Smart Upgrade database in the server’s Configuration document

To complete the setup of the Smart Upgrade database, a database link to the Smart Upgrade database must be created in the server’s Configuration document. Depending on the type of deployment method being used, this will be done in either a "* - [Default]" Server Configuration document, an individual server Configuration document, or in a Server Group Configuration document.

To add the Smart Upgrade database to the server’s Configuration document:

1. In the Domino Administrator client, click the **Files** tab.
2. Highlight the Smart Upgrade database that you created, and choose **Edit → Copy as link → Database link**.
3. On the Configuration tab, open the **Server → Configurations** view.
4. Select the Configuration document for the server, and click either **Edit Configuration** to edit the existing Configuration document or **Add Configuration** to create a new Server or Server Group Configuration Document. For more information about Server Configuration Documents, see the Administrator Help.

**Important:** Smart Upgrade first checks for the Smart Upgrade database link in the Configuration document of the Home/mail server specified in the Notes client Location document. If that Configuration document does not contain a Smart Upgrade database link, Smart Upgrade next checks the "* - [Default]" Configuration document for the database link. Depending on which deployment topology is in use, either the "* - [Default]" Configuration document or each Domino server’s individual Configuration document will have to be edited.

5. On the Smart Upgrade tab of the Configuration document, paste the database link in the Smart Upgrade Database link field using **Edit → Paste**, as shown in Figure 3-4.

![Figure 3-4  Defining the Smart Upgrade database in the * - [Default] Configuration document](image)

6. To verify that the database link is correct, right-click the database link and select **Link Properties**. This shows the database replica ID and server name (Figure 3-5 on page 20).
7. Save and close the Configuration document.

**Attention:** In this example, the fields dealing with the Smart Upgrade Governor that are located in the Configuration document have not been configured. For further information, refer to 5.4.1, “Enabling the Smart Upgrade Governor” on page 49.

In our scenario, ITSO Bank is using a distributed deployment topology, so the administrator has created two separate Smart Upgrade databases, one in the U.S. and one in France. Each Smart Upgrade database is applied to the corresponding Domino servers in the different geographical locations. This forces each user to use the Smart Upgrade database on their own Home/mail server.

To apply the correct Smart Upgrade database to the correct server, Bob creates a database link for the correct Smart Upgrade Database in the Paris Server Configuration Document and in the Server Configuration Document for the US Servers group. (The US Servers group contains both the Boston and LA Domino server). In Figure 3-6 Bob has checked to make sure that the Database Link that was copied into the US Server's Configuration document is for the Smart Upgrade database located on the Boston/ITSObank server.

In Figure 3-7 on page 21 Bob has checked to make sure that the Database Link that was copied into the Paris/ITSOBank Configuration document is for the Smart Upgrade database located on the Paris/ITSObank server.
Chapter 3. Creating the Smart Upgrade database

Figure 3-7  Configuration document for the Paris/ITSObank Server showing the correct DB link

**Note:** In the ITSO Bank scenario, a "* - [Default] Configuration document is not being used. This is because there are two separate Smart Upgrade databases (for the United States and France), and it is not appropriate to direct Notes clients to one single server for Smart Upgrade.

In Domino environments where there is a "* - [Default] Configuration document, Smart Upgrade looks at the user's Home/mail server Configuration document first, and uses the database link in that Configuration document if one exists. Then it checks for Group Server's Configuration documents. If no database link is found in the Home/mail server's Configuration document or a Server Group Configuration document, Smart Upgrade checks the "* - [Default] Configuration document for the location of the centralized Smart Upgrade database. If found, this database will be used.
The Smart Upgrade kit document

Smart Upgrade Kit documents are the heart of the Smart Upgrade process. A Smart Upgrade database can contain several kits. For example, there can be a kit for just the single Notes client, the All Client kit, a Macintosh platform, or to apply a Cumulative Client Hotfix (CCH). Smart Upgrade Kit documents control which Notes client versions will be upgraded, how the upgrade will take place, which installation kits are used for the upgrade, and which users will be able to access the installation kits. Administrators should use careful planning and test the output of the application of the kit documents before applying them to production users.

In this chapter, we discuss the following topics:
- Planning to create the Smart Upgrade kit documents
- Definition of the Smart Upgrade document fields
- Smart Upgrade pattern matching
- Using optional arguments when running Smart Upgrade
- Creating Smart Upgrade Kit documents
4.1 Planning to create the Smart Upgrade kit documents

Before creating Smart Upgrade kit documents an administrator should obtain:

- Notes client versions and installation types

Make a full list of Notes client versions, platforms, and types to be upgraded, and the version to which the clients will be upgraded. If there are multiple types of clients or versions, multiple Smart Upgrade Kit documents will have to be created.

Since Domino 6.5.5, Smart Upgrade has had the ability to determine the type of client installed: Notes client only or all clients. The Smart Upgrade process can upgrade to and from only the same installation type. For example, if the Notes client only is currently installed on the workstation, Smart Upgrade can be used only to upgrade to a newer release of the Notes Client only installation type. You cannot use Smart Upgrade to upgrade the Notes Client only installation to an All Clients installation. If you want to change the installation type, you must manually upgrade the client to the desired installation type. From that point moving forward Smart Upgrade can be used moving forward to upgrade the client.

Tip: If both Version 6.0.5/6.5.4 or previous clients and 6.5.5 or higher clients are installed, separate Smart Upgrade Kit documents will be required for each version group; one for 6.5.4 or earlier, and one for 6.5.5 and later. If there are Notes Client only and All Clients Notes installations as well, then specific Smart Upgrade Kit documents will also be needed for each of these.

Specifying “Notes Client only” or “All Clients” in a Smart Upgrade Kit upgrade requires Version 6.5.5 on both the Domino server and Notes client.

Notes 6.5.4 and earlier clients can have only one matching Smart Upgrade Kit document per user, per source version. If you attempt to configure multiple kits for a 6.5.4 or earlier source version—one for Notes Client Only and one for All Clients—Smart Upgrade will fail. If the user manually initiated the Smart Upgrade (using File → Tools → Notes Smart Upgrade), an error message will indicate that duplicate kits have been found for that user in the Smart Upgrade database.

- Client installation packages

Installation packages can be downloaded from the IBM Web site or copied from an original Lotus Notes and Domino product CD. For further information about installation packages, refer to Appendix A, “Understanding Smart Upgrade kits” on page 65.

- Physical location of the Notes clients

Know which Notes clients require upgrade, and plan where the installation packages will be located. Installation packages can be attached to the Kit document, stored on a network drive, or unpacked and stored on a shared network drive that users can access. For more information, refer to Chapter 2, “Planning to upgrade the Notes clients” on page 7.

- Smart Upgrade topology

Is this a consolidated or distributed Smart Upgrade deployment? Depending on which topology is being used, the Smart Upgrade kits will be created in one central Smart Upgrade database or replicated to several servers. Alternatively, there may be more than one separate Smart Upgrade database. For further information about deployment methods, refer to 3.2, “Deployment of the Smart Upgrade database” on page 17.
4.2 Definition of the Smart Upgrade document fields

In this section we review the Smart Upgrade kit document, and the fields on the document. The Smart Upgrade document has two tabs: the Basics tab and the Administration tab.

4.2.1 The Basics tab

The Basics tab (Figure 4-1) shows all of the settings for the Smart Upgrade configuration.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kit description</td>
<td>Enter a brief description of the kit. After completing this document, this kit description is used to identify the Smart Upgrade Kit document in the view.</td>
</tr>
<tr>
<td>Enable this kit for use</td>
<td>Select the Enabled check box to make the kit available to authorized users.</td>
</tr>
<tr>
<td>Source versions</td>
<td>Enter the current Notes client release, or enter a wildcard pattern to match a series of Notes client releases. Refer to 4.3, “Smart Upgrade pattern matching” on page 28, for information about acceptable wildcard patterns for the source version. Note: The asterisk (*) wildcard enables any client 6.0 or greater to upgrade to the destination version.</td>
</tr>
</tbody>
</table>

Figure 4-1 Default Smart Upgrade kit document: Basics tab

Tip: Most of the fields on the Smart Upgrade Kit document provide “fly-over” help about what the field is for and how the field should be populated. Hover the cursor over a field name in the document, and if the cursor changes to a hand, fly-over help is available and will be displayed if the cursor is left in that position.

Table 4-1 describes the fields on the Smart Upgrade Kit document Basics tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kit description</td>
<td>Enter a brief description of the kit. After completing this document, this kit description is used to identify the Smart Upgrade Kit document in the view.</td>
</tr>
<tr>
<td>Enable this kit for use</td>
<td>Select the Enabled check box to make the kit available to authorized users.</td>
</tr>
<tr>
<td>Source versions</td>
<td>Enter the current Notes client release, or enter a wildcard pattern to match a series of Notes client releases. Refer to 4.3, “Smart Upgrade pattern matching” on page 28, for information about acceptable wildcard patterns for the source version. Note: The asterisk (*) wildcard enables any client 6.0 or greater to upgrade to the destination version.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Operating system</td>
<td>Enter or select the operating system for which the kit is intended.</td>
</tr>
<tr>
<td>Localization</td>
<td>Enter or select the language of the Notes client that will be upgraded.</td>
</tr>
<tr>
<td>Release 6.5.4/6.0.5 or previous</td>
<td>This field displays only if you are using Microsoft® Windows® (Win32®). For version 6.5.4/6.0.5 or earlier Notes clients, Smart Upgrade does not recognize whether only the Notes client or all clients are installed. If the source version of the client to be upgraded is Notes 6.5.4/6.0.5 or earlier, select this check box.</td>
</tr>
</tbody>
</table>
| Install type                              | Only displayed if the field “Release 6.5.4/6.0.5 or previous” is set to No. Choose one:  
- Notes client only: Smart Upgrade installs the Notes Client Only kit.  
- All client (Notes client, Admin client, Designer): Smart Upgrade installs the All Client kit. |
| Destination version                       | Enter the version of the update. This is the same as the version text shown in the Notes client Help → About screen. For example, for 7.0.1, the text to enter in this field is: Release 7.0.1  
**Note:** If Policies are in use for the management of Smart Upgrade, the value of this field must match the value in the Deploy Version field of the Desktop Settings document. (See 5.2, “Configuring policies to assist with Smart Upgrade management” on page 38.) |
| Location                                  | Choose one of these to specify the location of the upgrade kit:  
- Attached to this note: Installation kit that has been packaged in a single executable is attached to the Smart Upgrade Kit Document.  
- On a shared network drive: Choose this option and enter the file path to the installation file in the “Full path to update kit” field. When you use the shared network drive option decompress the file, copy all files in the installation kit to the directory specified. Follow this convention: `\networkfilereservername\shareddirectoryname\setup.exe`  
- Shared network drive and attached kit with fail over: Choose this option, then select the file to attach that contains the Smart Upgrade Kit, and enter the full file path name to the SETUP.EXE file as shown above. |
| Restart Notes after update                | Select this option to have the Notes client restart automatically after the upgrade has completed.                                               |
| Optional arguments for shared network drive kit | Enter optional arguments if you are specifying a shared network kit. Example:  
/s /v"qb"  
This is a common option used for a silent install with a progress bar when the installation package has been unpacked or the installation files were copied from a CD to a network drive.  
For more information about optional arguments, refer to 4.4, “Using optional arguments when running Smart Upgrade” on page 29.  
**Note:** This field is visible only if the Location field has a “Shared Network Drive” option selected. |
| Optional arguments for attached kit        | Enter optional arguments if you are using an attached kit. Example:  
-s -a /s /v"/qn"  
This is a common option to not prompt where to save the temp files and install silently. Always enter a space after the /s.  
**Note:** This field is visible only if the Location field has an “Attached to this note” option selected. |
4.2.2 The Administration tab

The Administration tab of the Smart Upgrade Kit Document, shown in Figure 4-2, defines the users who will have the document applied to them and who the owner and administrators of the document are. There is also a field for comments.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message text</td>
<td>Enter the message that will appear when Lotus Notes Smart Upgrade prompts users to upgrade their Notes clients. There is a field limit of 16k for this field.</td>
</tr>
</tbody>
</table>

**Note:** The “Shared network drive and attached kit” option provides an “optional argument” field for the Shared network drive and the attached kit. The Smart Upgrade process checks whether the installation package is available on the network drive. If the installation package is accessible, it is used. If the installation package is not accessible on the network drive, the attached installation package is used.

Table 4-2 defines the fields found on the Administrator tab of the Smart Upgrade Kit document.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Allowed Users & Servers | Enter or select the users or servers allowed to upgrade their Notes clients using this kit document.  
To include all users in your organization, enter a value using the following format:  
*/OrgUnit/Organization/CountryCode*  
If this field is left blank, the kit will be applied to all users in the Domino Domain.  
**Note:** When you enter a value in this field, also add LocalDomainServers to this field because this is a “Readers” field. If LocalDomainServers is not included in the entries in this field, the kit will not replicate to other Domino servers in the domain. |
| Owners        | Enter or select the persons who own this document.                                                                                        |
| Comments      | *(Optional) Enter comments such as the update history for this document.*                                                                 |

Figure 4-2  Smart Upgrade Kit Document - Administration Tab
4.3 Smart Upgrade pattern matching

Domino compares the version of the user's Notes client to the version specified in the Source Version field of the kit document in the Lotus Notes Smart Upgrade database. The version of the client is the text shown on the Help → About screen of the Notes client. For example, the text for a Version 6.5.5 Notes client is Release 6.5.5, as shown in Figure 4-3.

Pattern matching (wildcard characters), introduced in Notes version 6.5.1, can also be used in place of some or all of the version text. This enables a single kit document to be used for several source versions.

You can use any of the pattern matching expression rules shown in Table 4-3 when entering the version in the Source Version field of the Kit document.

Table 4-3 Pattern Matching examples

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any character (for example, C)</td>
<td>Matches any single non-special character. In this example, it matches C.</td>
</tr>
<tr>
<td>\C</td>
<td>Matches the single character even if it is a special character. In this example, it matches C.</td>
</tr>
<tr>
<td>?</td>
<td>Matches any single character.</td>
</tr>
<tr>
<td>{ABN}</td>
<td>Matches any character in the set (A,B,N).</td>
</tr>
<tr>
<td>{!ABN}</td>
<td>Matches any character not in the set (A,B,N).</td>
</tr>
<tr>
<td>{A-FH-K}</td>
<td>Matches any character in the set (A...F,H...K).</td>
</tr>
</tbody>
</table>
The most commonly used wildcards and expressions are * and ?; for example:

- **Release 6.5.4* would match:**
  - Release 6.5.4
  - Release 6.5.4FP1
  - Release 6.5.4FP2
  - Release 6.5.4FP3
  - Release 6.5.4HF719

- **Release 6.5.4FP? would match:**
  - Release 6.5.4FP1
  - Release 6.5.4FP2
  - Release 6.5.4FP3

- **Release 6.5.* would match:**
  - Release 6.5.1
  - Release 6.5.2
  - Release 6.5.3
  - Release 6.5.3HF719

**Tip:** In most cases, the Source Version field contains the asterisk (*) wildcard to allow any Notes 6.0 or higher version of the Notes client to be upgraded to the Destination version.

Using * in the Source version field of the Smart Upgrade Kit document results in all Notes clients being prompted to Smart Upgrade, if the Destination version specified in the kit document is later than the current (source) version of the Notes client and the users have access to the Smart Upgrade Kit document via the Allowed Users & Servers field.

When using a convention such as 6.5.* or 6.0.*, clients earlier than 6.5.1 will not recognize the kit because Pattern Matching was not introduced until Notes 6.5.1.

### 4.4 Using optional arguments when running Smart Upgrade

You can use optional arguments when launching Smart Upgrade, to control the user interaction with the installation process.

**Tip:** Smart Upgrade can launch any type of executable, so the command line arguments in the Smart Upgrade Kit document are specific to the executable file referenced in the document, not to the Smart Upgrade itself.

Optional arguments can be used with either installation files on a shared network drive, or with an installation package attached to a Kit document. Optional arguments are commonly
used to run a silent Smart Upgrade requiring no user input during the upgrade, or to launch an upgrade that is “almost silent” requiring almost no input from users. Table 4-4 shows a list of common command line arguments and their definitions.

**Table 4-4 Optional command line arguments**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>/s</td>
<td>Instructs setup.exe to run in silent mode.</td>
</tr>
<tr>
<td>/v</td>
<td>Passes arguments to Msiexec.exe. Used with command lines for Msiexec.exe; for example, /v&quot;qb+&quot; would pass the qb+ command to the MSI installer. The commands are surrounded by quotation marks. There is no space between the /v and the quotation marks.</td>
</tr>
<tr>
<td>/qn+</td>
<td>No user interface displayed during the installation of the client except for a modal dialog box displayed at the end to notify that the installation was completed.</td>
</tr>
<tr>
<td>/qb+</td>
<td>User sees progress bar showing status of the installation of the client with a modal dialog box displayed at the end to notify that the installation was completed. The modal box is not displayed if the user cancels the installation. Use qb+! or qb!+ to hide the Cancel button.</td>
</tr>
<tr>
<td>-d</td>
<td>Specifies that installation files are extracted to a temporary directory, from which they are deleted when the update is complete. -d must be first in the series of arguments. This argument is used when using a installation kit that is packaged in a single .exe file.</td>
</tr>
<tr>
<td>-s</td>
<td>Makes the unpacking of the detached kit on the user’s computer silent and uses the default locations for the files it will extract.</td>
</tr>
<tr>
<td>-a</td>
<td>Passes all arguments to the file that is being launched. For example, -a used in launching a single file installation kit would pass further arguments to the installer application. Example: -s -a /s /v&quot;qb+&quot; passes the arguments /s /v &quot;qb+&quot; to setup.exe</td>
</tr>
</tbody>
</table>

### 4.4.1 Creating a silent installation on a shared network drive

Shared network kits can be used with arguments that initiate a silent installation that bypasses the Lotus Notes Installation dialog boxes and uses the settings from the last installation of the client on that workstation.

Arguments entered in the field: “Optional arguments for shared network drive kit” are used to set the installation options. To run a silent install from installation files extracted to a network drive or that were copied from an installation CD, use the format shown in this example:

```
s /v"/qn"
```

- /s initiates a silent installation. Always enter a space after the /s.
- /v indicates that the /qn parameters are passed to MsiExec. /qn will force the installation without a progress bar. With this option set, there will be no indication to the user that an installation is occurring.

**Tip:** Use of the /qn parameter can be problematic because the user is not visually shown that an installation is in progress and could accidentally cancel the upgrade by shutting down the operating system or taking other actions.

Use the b parameter to display a progress bar during the upgrade, in addition to displaying the message indicating that the upgrade is complete or has failed. Example: `/s /v"qb+"

- /s initiates a silent installation. Always enter a space after the /s.
4.4.2 Creating a silent installation for an attached installation kit

Optional parameters can also be used to produce a silent installation for attached installation kits. This example applies to situations where you are referencing installation kits attached to the Smart Upgrade Kit document. Arguments are entered into the “Optional arguments for attached kit” field. Example:

```
-s -a /s /v"/qb"
```

- `-s` makes the unpacking of the single installation file on the user’s computer silent and uses the default location for the files it will unpack.
- `-a` indicates that the additional arguments that follow are to be passed to the Lotus Notes installer after the unpacking is complete.
- `/s` initiates a silent installation. Always enter a space after the `/s`.
- `/v` indicates that the "/qb" parameters are passed to MsiExec. /qb will display a progress bar showing the status of the client installation. There is no space between the `/s` and the quotes that contain the arguments to be passed.

4.4.3 Using Transform files in Smart Upgrade

In most cases, the use of a Transform file (.mst) is not necessary when upgrading a Notes client. This applies when upgrading using Smart Upgrade as well.

If the existing Notes client is installed to a non-default path (something other than C:\Program Files\Lotus\Notes), the Notes Installer will recognize the existing client and install to the correct directory, so a Transform file is not needed.

In the case where a Transform file is needed to modify the installation, it can be applied during the Smart Upgrade Process by adding the `TRANSFORMS=` line to the arguments passed to the MSI installer. For example, one case in which the use of a Transform file might be needed is when a customized template must be applied at upgrade, or when the administrator would like to add a notes.ini parameter during the upgrade process.

Transform files can be applied to installation files stored on a network drive or to a kit attached to the Smart Upgrade Kit document. The following optional argument shows how a Transform file is applied on a command line for installation files stored on a network drive:

```
/s /v"TRANSFORMS="\itsobankfileserver\notes7\upgrade.mst" /qb+
```

The following optional argument shows how a Transform file is applied on a command line for a kit attached to the Smart Upgrade Kit document:

```
-s -a /s /v"TRANSFORMS=\\itsobankfileserver\notes7\upgrade.mst /qb+
```

For further information about creating Transform files, refer to Technote 1109400, “General overview of how to perform a Silent Install of Notes 6.x or 7.x Client” at:

http://www.ibm.com/support/docview.wss?rs=899&uid=swg21109400
4.5 Creating Smart Upgrade Kit documents

Smart Upgrade Kit documents are created in the Smart Upgrade database and are available only to users who connect to that Smart Upgrade database.

If there are multiple separate Smart Upgrade databases in the environment, the administrator would create Smart Upgrade Kit documents in each of the databases. If the Smart Upgrade database is replicated across the domain, then the administrator has to create the Smart Upgrade Kit document only once in the Smart Upgrade database and it will replicate to the other replicas.

To create a Smart Upgrade Kit document:
1. Open the Smart Upgrade database on the Domino server either from the Notes client or Administrator client.

2. Click **New Kit** in the default view, as shown in Figure 4-4.

3. Complete the fields on the Basics tab (Figure 4-5) based on the needs of your environment. (See 4.2, “Definition of the Smart Upgrade document fields” on page 25.)

4. Complete the fields on the Administration tab (Figure 4-6 on page 33) based on the needs of your environment.
5. Save and close the document.

4.5.1 ITSO Bank Smart Upgrade documents

Following our scenario, ITSO Bank has multiple versions of Notes clients, both pre-6.5.5 and 6.5.5 English version clients as well as Notes 6.5.3 French Notes clients. Administrator Bob has created a Smart Upgrade database on the Boston/ITSObank server and another separate database on the Paris/ITSObank server. He now needs to create the Smart Upgrade Kit documents.

To upgrade the existing English Notes clients that are using Version 6.5.4 or earlier, Bob creates a Smart Upgrade Kit document (Figure 4-7) that will be applied to English Client Only installations. It will use the Notes Client Only 7.0.1 Full Installation Kit that has been extracted to a network drive and is also attached to the Kit document for failover capabilities. The upgrade will run silently, showing only a progress bar so that the user is aware that the installation is occurring and can cancel out of it if needed.

In this example this Smart Upgrade Kit will be applied to all users.
To upgrade the existing English Notes clients that are using Client Only installations V6.5.5 or later, including Notes 7.0, Bob will create a Smart Upgrade Kit document shown in Figure 4-8 that will be applied to English Client Only installations. It will use the Notes Client Only 7.0.1 Full Installation Kit that has been extracted to a network drive and is also attached to the kit document for failover capabilities. The upgrade will run silently showing only a progress bar so that the user is aware that the installation is occurring and can cancel out of it if needed.

### Figure 4-8  ITSO Bank Smart Upgrade Kit document upgrading V6.5.5 and later Client Only installations

<table>
<thead>
<tr>
<th><strong>Smart Upgrade Kit: Upgrade Kit 6.5.5+ =&gt; 7.0.1</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Base</strong></td>
</tr>
<tr>
<td><strong>Details</strong></td>
</tr>
<tr>
<td><strong>Stick description:</strong></td>
</tr>
<tr>
<td>Enable this kit for use</td>
</tr>
<tr>
<td><strong>This Smart Upgrade kit can be used to update the following versions of Lotus Notes:</strong></td>
</tr>
<tr>
<td>Version:</td>
</tr>
<tr>
<td>Operating system:</td>
</tr>
<tr>
<td>Localization:</td>
</tr>
<tr>
<td>Release 6.5.4 or previous?</td>
</tr>
<tr>
<td>Install Type:</td>
</tr>
<tr>
<td><strong>After applying this kit, the client will be running this version of Lotus Notes:</strong></td>
</tr>
<tr>
<td>Destination version:</td>
</tr>
<tr>
<td>Restart Notes after update:</td>
</tr>
<tr>
<td><strong>Location of update kit:</strong></td>
</tr>
<tr>
<td>Location:</td>
</tr>
<tr>
<td>Full path to update kit:</td>
</tr>
<tr>
<td>Optional arguments for shared network drive kit:</td>
</tr>
<tr>
<td>Optional arguments for attached kit:</td>
</tr>
<tr>
<td>Optional arguments for K绝对不会:</td>
</tr>
<tr>
<td><strong>Optional message to end users (appears in update prompt):</strong></td>
</tr>
</tbody>
</table>

The Install Type field is displayed because this kit document is not set for release 6.5.4/6.0.5 or earlier.
ITSO Bank has a number of Notes developers and administrators who use the All Client Installation version 6.5.5. To upgrade the existing English Notes clients that are using All Client installations 6.5.5 or later, including Notes 7.0, Bob creates a Smart Upgrade Kit document (Figure 4-9) that will be applied to English All Client installations. It will use the All Client 7.0.1 Full Installation Kit that has been extracted to a network drive and is also attached to the Kit document for failover capabilities. The upgrade will run silently showing only a progress bar so that the user is aware that the installation is occurring and can cancel out of it if needed.

![Smart Upgrade Kit: All Client - Upgrade Kit 6.5.5+ => 7.0.1](image)

**Figure 4-9** ITSO Bank Smart Upgrade Kit document upgrading version 6.5.5 and later All Clients installations

To upgrade the existing French Notes clients that are using version 6.5.4 or earlier to Notes release 7.0.1, Bob creates a Smart Upgrade Kit document (Figure 4-10 on page 36) in the Smart Upgrade Database on the Paris/ITSObank server that will be applied to French client only installations. It will use the Notes client only 7.0.1 Full Installation Kit attached to the Kit document. The upgrade will run silently showing only a progress bar so that the user is aware that the installation is occurring and can cancel out of it if needed.

**Important:** In the example above, if any users are using an All Client installation, they will not be upgraded.
When the documents are completed, they can be seen in the default view of the Smart Upgrade database. Figure 4-11 shows the ITSO Bank's default view of the two Smart Upgrade databases. These views can be sorted by From Version (Source version) or To Version (Destination Version). To sort the view, click the column heading for the desired sort order. Each kit will also show whether it is enabled or disabled in the view.
Advanced configuration

This chapter provides options to help Domino administrators more effectively control the Smart Upgrade process.

The following advanced configuration topics are discussed:

- Configuring policies to assist with Smart Upgrade management
- Tracking Smart Upgrade results
- Limiting concurrent downloads with the Smart Upgrade Governor
- Using clustering to enable failover for Smart Upgrade

Throughout the chapter we build on the Smart Upgrade configuration discussed in Chapter 3, “Creating the Smart Upgrade database” on page 15, to describe how Bob, the ITSO Bank Domino administrator, could implement some more advanced features of Smart Upgrade to enhance his control over the Smart Upgrade process.
5.1 Introduction to advanced Smart Upgrade configuration

The topics in this chapter describe the optional extra configuration tasks for Smart Upgrade. The advanced features of Smart Upgrade provide two main benefits to the Domino administrator:

1. A greater level of control and flexibility: Policies, the Smart Upgrade Governor, and clustering provide the Domino administrator with better control over which users will be upgraded and when the upgrades will occur.

2. More information through tracking and reporting: The options for reporting Smart Upgrade results enable the Domino administrator to clearly track the upgrade status of the user population. This allows additional troubleshooting and manual assistance to be targeted to individual users who require it.

5.2 Configuring policies to assist with Smart Upgrade management

Domino Policies were introduced in Lotus Notes and Domino 6, to provide Domino administrators with additional options to help manage their Notes users and workstations. Policy documents and Policy Settings documents are stored in the Domino Directory. For further information about Domino Policies, refer to the “Policies” topic in the Lotus Domino Administrator 7 Help database.

Policies are not a mandatory part of Smart Upgrade, because Smart Upgrade will prompt users to upgrade even if there is no Policy applied to them (if a matching kit document is found for them). Policies can optionally be configured with Smart Upgrade settings, to provide additional control over the Smart Upgrade deployment.

In Domino 7, the Smart Upgrade Policy settings are stored in the Desktop Settings document on the Smart Upgrade tab as shown in Figure 5-1.

Note: Prior to 6.5.3, the Smart Upgrade options were available on the Basics tab of the Desktop Settings document. Starting with Domino 6.5.3, the settings are located on the new Smart Upgrade tab. Additional fields were also added in Domino 6.5.3, to enhance the management of Smart Upgrade through Policies.
5.2.1 Policy settings for managing Smart Upgrade

Using Smart Upgrade Policy settings, the Domino administrator can:

- Specify a deploy version for users
- Set an upgrade deadline
- Track the status of user Smart Upgrade attempts

Table 5-1 describes in more detail the fields for Smart Upgrade Policy settings.

**Table 5-1 Policy Settings for Smart Upgrade management**

<table>
<thead>
<tr>
<th>Field name (Desktop Settings document)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deploy version</td>
<td>Enter the Notes version to which you want users to upgrade. This version will be enforced on all users for whom the Policy applies.</td>
</tr>
<tr>
<td>Upgrade deadline</td>
<td>Specify the date by which users must upgrade. If users do not upgrade by this date, the upgrade happens automatically. <strong>Note</strong> This field appears only if the “Deploy Version” field is populated.</td>
</tr>
<tr>
<td>Remind me every hour after “upgrade deadline” has passed</td>
<td>Check this field if you want to allow users who have not upgraded their clients by the deadline set in the “Upgrade deadline” field to postpone the upgrade by one hour. <strong>Note</strong> This field appears only if you the “Upgrade Deadline” field is populated.</td>
</tr>
<tr>
<td>Mail-in Database for Smart Upgrade reports</td>
<td>Enable Smart Upgrade Tracking for the user by selecting the mail-in database name.</td>
</tr>
</tbody>
</table>
| Remove Smart Upgrade tracking files after a specified number of days | Choose one:  
  - Yes: Automatically deletes the Smart Upgrade tracking files when the specified time period for maintaining files is exceeded and the Notes client is restarted.  
  - No: Retains the Smart Upgrade tracking files. |
| Number of days to keep Smart Upgrade Tracking reports files | Enter the number of days to keep the Smart Upgrade Tracking files before they are deleted. Default is 365 days.  
This field applies only to Notes 6.0.5/6.5.3 and later. Earlier clients will ignore this setting.  
**Note** This field appears only if you choose Yes in the “Remove Smart Upgrade tracking files after a specified number of days” field. |

**Note:** Upgrade deadline settings are observed only by V6.5.1 and later Notes clients. Smart Upgrade Tracking Reports are generated only by V6.5.3 and later Notes clients. For more about version feature dependencies, see “Version-specific requirements” on page 68.
5.2.2 Example: Deploying policies at ITSO Bank

At ITSO Bank, Bob the Domino administrator has deployed the Smart Upgrade databases to his Boston, Los Angeles (LA), and Paris servers. He would like to ensure that all of his users upgrade to Lotus Notes 7.0.1 by end of June.

The following steps show how Bob can achieve this:

1. Create a Desktop Settings document in the ITSObank Domino Directory:
   a. In the Domino Administrator client, open the Boston server (the Administration server).
   b. On the People & Groups tab and select the Settings view.
   c. Click Add Settings and select Desktop. Select Yes if prompted with the warning about 4.67a servers/clients.
   d. On the Basics tab, fill in the Name and Description fields (Figure 5-3).
   e. On the Smart Upgrade tab, the following fields are completed:
      - **Deploy version**: Release 7.0.1
      - **Upgrade Deadline**: June 30 2006 (choose from the date picker - this uses the system date format)

      Select **Remind me every hour after the upgrade deadline has passed**.

      **Important:** The “Deploy version” field in the Desktop Settings document must exactly match the “Destination version” field in the Smart Upgrade Kit document, as shown in Figure 5-4.
Figure 5-4  Matching the Destination Version field

f. Save and close the Desktop Settings document.

2. Create a Policy document in the ITSObank Domino Directory:
   a. Still on the People & Groups tab, select the Policies view.
   b. Click Add Policy. Select Yes if prompted with the Warning about 4.67a servers/clients.
   c. On the Basics tab, fill in these fields as shown in Figure 5-5:
      - **Policy name**: ITSObank
      - **Policy type**: Organizational
      - **Description**: Description of what the Policy is for, such as ITSObank Policy to manage Smart Upgrade

   ![Policy - Basics](image)

   Figure 5-5  Policy for Smart Upgrade - Basics

   d. In the Setting Type section, select the Desktop Settings document created in Step 1 as depicted in Figure 5-6.

   ![Setting Type](image)

   Figure 5-6  Selecting the Desktop Settings document

   e. Save and close the Policy document.
5.3 Tracking Smart Upgrade results

By tracking the Smart Upgrade process, administrators can find out which users have upgraded. There are three basic methods for tracking Smart Upgrade across all clients in an organization:

- The Smart Upgrade Tracking Reports database
  This is usually the first place to check for Smart Upgrade status information for Notes and Domino 6.5.3 and later. This mail-in database tracks all successful, cancelled, and failed Notes client Smart Upgrade attempts.

- Smart Upgrade logging on the Notes client
  The Notes client stores a smartupgrade*.log file, which logs useful information about the upgrade process on that client.

- Checking the Notes client version in the Domino Directory
  Each Person document in the Domino Directory stores details of the user's Notes client version. This may be used to check or summarize Notes client version information.

5.3.1 The Smart Upgrade Tracking Reports database

The Smart Upgrade Tracking Reports database is a mail-in database, based on the Lotus Notes/Domino Smart Upgrade Tracking Reports (LNDSUTR.NTF) system database template.

Beginning in Domino 6.5.3, this database is created automatically at first server setup for new Domino installations. For existing Domino installations, the database and mail-in database document can be created manually. (Refer to “Creating the Smart Upgrade Tracking Reports database manually” on page 42 for instructions.)

**Note:** The Smart Upgrade Tracking Reports functionality was added in Lotus Notes and Domino 6.5.3. This means that both the Domino server and the Notes clients must be at a minimum of 6.5.3 for the tracking reports to be generated.

The Smart Upgrade Tracking Reports database can be used to determine whether the Notes clients are upgrading successfully when using Smart Upgrade, or to determine which users are experiencing problems. If there are instances where Smart Upgrade fails, use the information in the report to assist in determining the problem without having to visit the user's desktop. You can also use the reports to determine whether there is a repeating problem on multiple clients that could be related to the configuration of the Smart Upgrade database containing the kit information.

**Tip:** If SmartUpgrade log files are not being generated on a Notes client, this is also indicative of a problem. Refer to Appendix B, “Troubleshooting basics” on page 75, for assistance with troubleshooting Smart Upgrade issues.

**Creating the Smart Upgrade Tracking Reports database manually**

For Domino environments that have been upgraded from previous versions of Domino (prior to Domino 6.5.3), the Smart Upgrade Tracking Reports database will not be created automatically.

Bob, the ITSO Bank Domino administrator, upgraded his Domino servers from an earlier version of Domino, so he has to create his Smart Upgrade Tracking Reports database
manually on the Administration Server (Boston/ITSObank). To do this, he must complete these steps:

1. In the Domino Administrator client, click File → Database → New.
2. In the New Database dialog, fill in details as shown in the example in Figure 5-7.

3. Click OK to create the database.
4. In the People & Groups tab of Domino Administrator (on Boston/ITSObank), open the Mail-in Databases and Resources view.
5. Click Add Mail-in Database.
6. Fill in the Mail-in Database document as shown in the example in Figure 5-8.
7. Save and close the document.
Configuring the Smart Upgrade Tracking Reports database

The Smart Upgrade Tracking Reports database is configured in the Desktop Settings document in the Domino Directory.

The ITSO Bank Smart Upgrade Tracking Reports database will be configured by editing the Desktop Settings document created in 5.2.2, “Example: Deploying policies at ITSO Bank” on page 40, as follows:

1. In the Domino Administrator client, open the Boston server (the Administration server)
2. Click the People & Groups tab and select the Settings view.
3. Click the ITSObankSU Settings document and click Edit Settings.
4. Click the Smart Upgrade tab, and fill in the mail-in database name and preferences for report retention days, as shown in the example in Figure 5-9.

![Figure 5-9: Smart Upgrade Tracking Reports configuration in Desktop Settings document](image)

**Note:** The Mail-in Database field is automatically populated if the Smart Upgrade Tracking Reports database was created automatically at first server setup. If you created the mail-in database manually, you also have to select it manually in the Desktop Settings document.

5. Save and close the ITSObankSU Desktop Settings document.

Using the Smart Upgrade Tracking reports

Each time a Notes client attempts a Smart Upgrade, a tracking report is mailed to the Smart Upgrade Tracking Reports database. If the Smart Upgrade process fails or is cancelled by the Notes user, the tracking report is mailed to the database immediately. If the Smart Upgrade process is successful, the tracking report is mailed to the database at the next Notes client startup (after Smart Upgrade has completed).

**Note:** Only Version 6.5.3 and later Notes clients have the ability to send tracking reports to the Smart Upgrade Tracking Reports database. For earlier clients, use one of the tracking methods described in “The lotusinstall.log” on page 47 or 5.3.3, “Checking the Notes client version in the Domino Directory” on page 48.

Table 5-2 describes the view options that are available for tracking reports.

<table>
<thead>
<tr>
<th>View option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>By status</td>
<td>Reports grouped by result:</td>
</tr>
<tr>
<td></td>
<td>▶ Failed</td>
</tr>
<tr>
<td></td>
<td>▶ Cancelled</td>
</tr>
<tr>
<td></td>
<td>▶ Succeeded</td>
</tr>
<tr>
<td>By date</td>
<td>All reports categorized by date, then user name</td>
</tr>
</tbody>
</table>
Tracking reports contain a wealth of information about each Smart Upgrade attempt. Figure 5-10 shows an example of a Smart Upgrade Tracking Report for a Smart Upgrade process that was cancelled manually by the user.

Table 5-3 describes each of the fields in the Smart Upgrade Tracking Report document shown in Figure 5-10.
<table>
<thead>
<tr>
<th>Field</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notes/Domino Name</td>
<td>Julie Castle/ITSObank</td>
<td>The user's Notes user name</td>
</tr>
<tr>
<td>Notes/Domino Version</td>
<td>Release 6.5.5</td>
<td>The current Notes client version, or the From Version for successful upgrades</td>
</tr>
<tr>
<td>Program Directory</td>
<td>C:\Program Files\lotus\notes C:\Program Files\lotus\notes\data</td>
<td>The Notes client program and data directories</td>
</tr>
<tr>
<td>Data Directory</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tmp Space Available C</td>
<td></td>
<td>Space details on the workstation, in megabytes</td>
</tr>
<tr>
<td>Tmp Space Required C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>Smart Upgrade to 701 * Release 7.0.1</td>
<td>Details from the matching Smart Upgrade Kit document. For Failed Smart Upgrades, this section is not included in the report.</td>
</tr>
<tr>
<td>From Version To Version</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Policy</td>
<td>*/ITSObank</td>
<td>Details of the user's assigned Desktop Policy</td>
</tr>
<tr>
<td>Desktop Settings</td>
<td>*ITSObankSU</td>
<td></td>
</tr>
<tr>
<td>Deploy Versions</td>
<td>Release 7.0.1</td>
<td></td>
</tr>
<tr>
<td>OS Name</td>
<td>Administrator or jcastle</td>
<td>Operating system logon in use on the workstation during the Smart Upgrade process</td>
</tr>
<tr>
<td>OS Version</td>
<td>Microsoft Windows XP Professional Service Pack 1</td>
<td>Operating system version and fixpack (service pack) level</td>
</tr>
<tr>
<td>OS Machine Name OS Domain Name</td>
<td>MOBIPC</td>
<td>The workstation's operating system Computer Name and Workgroup or Domain name</td>
</tr>
<tr>
<td>Triggered from Menu</td>
<td>Yes or No</td>
<td>Whether the Smart Upgrade triggered automatically, or the user triggered the process manually (File → Tools → Smart Upgrade)</td>
</tr>
<tr>
<td>Start Time Stop Time Next Check</td>
<td>04/25/2006 05:31:39 AM 04/25/2006 05:31:53 AM 04/26/2006 05:31:53 AM</td>
<td>When the Smart Upgrade process occurred, and when the next process is due to occur. <strong>Note:</strong> Uses time/date settings on the workstation, not the Domino server.</td>
</tr>
<tr>
<td>Status</td>
<td>Successful, Cancelled, or Failed</td>
<td>The status of this Smart Upgrade attempt</td>
</tr>
<tr>
<td>Error Message</td>
<td>There were no matching kits found in the Smart Upgrade database SmartUpg.nsf on boston/ITSObank. Please notify your Notes administrator POLICY: */ITSObank DESKTOP SETTINGS: SmartUpgrade DEPLOY VERSION: Release 7.0.1</td>
<td>Message that the client generated as a result of the process (for Failed and Cancelled Smart Upgrade attempts)</td>
</tr>
<tr>
<td>Home Server Smart Upgrade Database</td>
<td>boston/ITSObank boston/ITSObank/smartupg.nsf</td>
<td>The user's home server and Smart Upgrade location</td>
</tr>
</tbody>
</table>
5.3.2 Smart Upgrade logging on the Notes client

The Smart Upgrade log

Notes clients from Version 6.5.3 record logging information in a smartupgrade*.log file located in the Lotus\Notes\Data\IBM_TECHNICAL_SUPPORT\SmartUpgrade directory.

A new log file is created in this directory for each Smart Upgrade attempt. The naming convention for the log file is: SmartUpgrade_\<ClientMachineName>_<Date>@<Time>.log (for example, SmartUpgrade_MobiPC_2006_05_04@05_48_17.log).

The Smart Upgrade log includes all of the parameters, fields, and settings that were used during the Smart Upgrade process, and is useful for troubleshooting any Smart Upgrade issues. For further information about Smart Upgrade troubleshooting, refer to Appendix B, “Troubleshooting basics” on page 75.

The Smart Upgrade log file is attached to the Smart Upgrade Tracking Report, which is sent in to the Smart Upgrade Tracking Report mail-in database by the Notes client after each Smart Upgrade attempt.

**Tip:** If Policies are not being used to manage Smart Upgrade in your environment, the Smart Upgrade log will still be created on the workstation. They can be viewed directly from the workstation if Smart Upgrade troubleshooting is required.

The lotusinstall.log

The lotusinstall.log file is created during Notes client installation (for Notes 6.0 and greater) and overwritten at each upgrade. During a Notes client installation, the file is created after the Windows Installer dialog box appears with a Preparing to install... message.

Installation processes initiated by Smart Upgrade also write to this file. This file lists various path statements, registry information, and possible error messages, and thus may be useful for troubleshooting certain Notes client installation or configuration issues.

By default, in Windows this file is located in the My Documents directory under the user's profile (usually this path: C:\Documents and Settings\WinLoginName\My Documents\).

If the installation process starts, the LotusInstall.log file gets written to by the Smart Upgrade process, then this file gets mailed into the Smart Upgrade Tracking Reports database as an additional attachment to the tracking report (along with the Smart Upgrade log file). This means that all “Successful” installation tracking reports will include the LotusInstall.log.

---

<table>
<thead>
<tr>
<th>Field</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Version</td>
<td>Release 6.5.5 November 30, 2005</td>
<td>The client's Notes version before and after the Smart Upgrade process</td>
</tr>
<tr>
<td>Final Version</td>
<td>Release 6.5.5 November 30, 2005</td>
<td>Note: These will be the same value for Failed and Cancelled Smart Upgrade attempts.</td>
</tr>
<tr>
<td>Log attachments</td>
<td><a href="mailto:SmartUpgrade_MobiPC_2006_05_04@05_48_17.log">SmartUpgrade_MobiPC_2006_05_04@05_48_17.log</a></td>
<td>The log file created on the workstation as a result of the Smart Upgrade process is attached to the Tracking Report. Note: The lotusinstall.log may also be attached.</td>
</tr>
</tbody>
</table>
importantly, many “Cancelled” and “Failed” tracking reports also contain the LotusInstall.log attachment. This can then be used to assist with troubleshooting the installation.

**Note:** Some Cancelled and Failed installations will not include the LotusInstall.log file. This indicates that the log file was not updated during the Smart Upgrade process. Typically this occurs when the user defers the upgrade (by choosing Upgrade Later), or the process is cancelled or fails very early in the process.

### 5.3.3 Checking the Notes client version in the Domino Directory

The Person Documents in the Domino Directory contain information about the Notes client version in use for each user in the organization.

**More information:** The Notes client version fields are updated by the “Update client information in Person Record” AdminP task. This task is triggered by the Notes client after an upgrade takes place. The Dynamic Client Configuration (DCC) task on the client checks the `Setup =` and `DYNINFOCR_...` lines in the client's notes.ini and triggers an update if these have changed.

The Domino administrator can view Notes client version information to check the most recently installed version on the client. The fields containing the Notes client version information are stored on the Administration tab of each Person Document, in the Notes client machine section, as shown in Figure 5-11.

![Notes client machine information from Domino Directory Person Document](image)

**Tip:** In the Notes client version section of the Person Document, there is a separate line for each workstation machine name. Each machine name is updated with the latest Notes client version used on that machine. If there are several lines displayed in this section, it indicates that the user has logged into Notes on more than one workstation. This means that the user either has multiple workstations, or the user's workstation hardware might have been replaced at some point in the past. The date displayed in the Updated at field for each workstation might provide a further clue.

The Notes client version fields may be used in a custom Notes view to summarize Notes client version information for the user population. Table 5-4 describes the fields that store this information in the Person Document (which could be used in a custom view).

<table>
<thead>
<tr>
<th>Field name</th>
<th>Display name</th>
<th>Description</th>
</tr>
</thead>
</table>
| ClntMachine    | Notes client machine | The workstation's operating system Computer Name.  
**Note:** This matches the “OS Machine name” field in Smart Upgrade Tracking Reports. |
| ClntBld        | Notes client build | The current Notes client version.  
**Note:** This matches the version shown in the Help → About screen of the Notes client. |
5.4 Limiting concurrent downloads with the Smart Upgrade Governor

The Smart Upgrade Governor minimizes administrative overhead by dynamically limiting Smart Upgrade downloads for kit documents that have attached kits, rather than requiring groups in Policies or in the Smart Upgrade Kit documents to do this. This is particularly useful for organizations that have limited bandwidth available.

Attention: The Smart Upgrade Governor limits concurrent downloads only for kits that are attached in the Smart Upgrade Kit documents. If the Smart Upgrade download uses a shared network location that is referenced in the kit document, the Governor will not limit these downloads.

For organizations for which bandwidth is limited, it is suggested that attached kits are used in the Smart Upgrade Kit documents so that concurrent downloads can be easily managed by the Smart Upgrade Governor.

Important: This functionality was added to Lotus Notes and Domino 6.0.5/6.5.4. Both the Domino server and Notes client have to be at 6.0.5/6.5.4 or greater to use the Smart Upgrade Governor. Earlier versions of the Notes client will ignore the Smart Governor. For further information about when specific features were added to Smart Upgrade, refer to “Version-specific requirements” on page 68.

5.4.1 Enabling the Smart Upgrade Governor

The Smart Upgrade Governor is enabled and configured in the Configuration document for the server or servers on which the Smart Upgrade database resides. When enabled, each server that contains a configured Smart Upgrade database keeps track of the number of concurrent Smart Upgrade downloads for that server (for attached kits only).

There are three possible settings for the Smart Upgrade Governor:

- **Enabled**: The Smart Upgrade Governor is active for limiting concurrent downloads on the server or servers to which this Configuration document applies.
- **Disabled**: The Smart Upgrade Governor is not in use on the server or servers to which this Configuration document applies.
- **Blank**: Leave the “Limit concurrent Smart Upgrade” field blank in an individual server Configuration document, and the Smart Upgrade settings from a group or "- [Default] Configuration document will be used on this server.
Understanding Lotus Notes Smart Upgrade

At ITSO Bank, Bob the Domino administrator wants to enable the Smart Upgrade Governor to minimize the number of concurrent Smart Upgrade attempts on the ITSObank servers. To enable Smart Upgrade Governor, Bob follows these steps:

1. In the Domino Administrator client, open the Boston/ITSObank server (the Administration server).
2. Click the Configuration tab and select the Server → Configurations view.
3. Choose the Boston/ITSObank Configuration document and click Edit Configuration.
4. Click the Smart Upgrade tab of the Configuration document, change the Limit Concurrent Smart Upgrades field to Enabled, as shown in Figure 5-13.

5. Type in a number for the Maximum Concurrent Downloads field. The default value is 100.

Note: At ITSO Bank, there is a mixture of client versions, including pre-6.0.5/6.5.4 clients. Bob knows that these earlier clients will ignore the Smart Upgrade Governor settings, so he has chosen to keep the concurrent downloads at a lower value than the default. Refer to “Version-specific requirements” on page 68 for suggestions for limiting concurrent downloads for earlier Notes client versions.

6. Save and close the document.
7. To update the configuration settings on the server immediately, at the server console type sucache refresh. The new Smart Upgrade Governor settings will be cached and displayed on the server console.

Note: “Disabled” is different from “blank” for the Limit concurrent Smart Upgrade field. Disabled means that the Governor is specifically disabled for this server; if the field is blank, the Governor settings in an applicable group or * - [Default] Configuration document will be used.

Tip: Use the Domino server command sucache show to display the details about the number of Smart Upgrade downloads and the Smart Upgrade Governor status. Figure 5-12 shows sample output for this command.
5.4.2 How the Smart Upgrade Governor works

The Smart Upgrade Governor is controlled by the settings in the Configuration document that relate to each server that contains a Smart Upgrade database. This means that either a * - [Default] Configuration document, a group Configuration document, or one for the individual server containing the database, must exist.

To check whether the Smart Upgrade Governor configuration is correctly loaded on the server, type `sucache show` on the server console of the server containing the Smart Upgrade database. Figure 5-14 shows an example of the output from this command.

![Governor configuration settings](image)

**Figure 5-14**  *sucache show* command, showing the Governor settings loaded

**Important:** Each server on which a Smart Upgrade database resides must have a Configuration document specifying the Smart Upgrade settings for that server. For example, it is possible to create a link for the Smart Upgrade database on Server2 in the Configuration document for Server1, but if you do this you must also create a Configuration document for Server2 (where the Smart Upgrade database resides).

This is required so that the full Smart Upgrade configuration (including the Governor settings) get loaded on the server where the Smart Upgrade database actually resides.

The server where the Smart Upgrade database resides may pull its configuration from either * - [Default] Configuration document, a group Configuration document, or an individual Configuration Document for that server.

When the Smart Upgrade Governor is enabled, each Smart Upgrade download that is initiated on the Notes clients is added to the Current statistic while the process is active. If the Current value reaches the Maximum value, the following events occur when a new request tries to initiate:

1. The new process request is rejected and the Rejected statistic on the server is incremented by one.
2. If the user manually initiated the Smart Upgrade request, the dialog box in Figure 5-15 appears. If Smart Upgrade automatically initiated for the user, no response is displayed.

![Smart Upgrade](image)

**Figure 5-15**  Manual initiation response when Governor limit is reached

3. The next update value in the workstation’s notes.ini is incremented by one hour.
4. A SmartUpgrade*.log file is created on the workstation.
5. If Smart Upgrade Tracking Reports are in use, a Tracking Report of type “Failed” is sent to the database.
Understanding Lotus Notes Smart Upgrade

5.5 Using clustering to enable failover for Smart Upgrade

The clustering awareness feature of Smart Upgrade was added in Lotus Notes and Domino 6.5.1. It enables the Notes client to initiate the Smart Upgrade process even if the primary upgrade server is not available.

When the Notes user logs on from a Notes client, the Configuration Settings document for the user’s Home/mail server is checked to locate the Smart Upgrade database link. If the server containing the Smart Upgrade database is not available, Smart Upgrade searches for alternative servers in the cluster.ncf file on the client, then by database replica ID and database name, for a replica server in the Smart Upgrade server cluster and tries to open the database on a replica server. If it is successful, the Smart Upgrade database on that replica server is used.

Note: The cluster-awareness feature uses normal clustering awareness. It therefore requires that the Notes client has connected to one of the clustered servers at least once in the past (and the Notes client subsequently closed) so that the cluster.ncf file exists on the Notes client. (This is the file used by the client to find alternative cluster-member servers in the event that their Home/mail server is unavailable.)

5.5.1 How to enable clustering awareness for Smart Upgrade

Bob, the ITSO Bank Domino administrator, has decided to cluster his two U.S. servers (Boston and Los Angeles) so that Notes users in the U.S. will be able to use Smart Upgrade even if their Home/mail server is unavailable. He can do this because there is a fast WAN link between these two sites. Bob has decided not to include his international site (Paris) in the cluster because the lower bandwidth on the international link is prohibitive to this option.

Note: No special configuration is required specifically to enable clustering awareness for Smart Upgrade. As long as the server is part of a cluster and each server in the cluster contains a replica of the Smart Upgrade database, clustering awareness will work for V6.5.1 and later Notes clients.

The ITSOBank U.S. servers are not currently clustered. To enable clustering awareness for Smart Upgrade on the Boston and LA servers, Bob takes these steps to create his cluster:

1. Ensure that the Boston and LA servers’ Smart Upgrade databases are replicas of each other.
2. Create the cluster:
   a. In the Domino Administrator client, open the Boston server (the Administration server).
   b. Click the Configuration tab and select the Server → All Server Documents view.

Tip: The Smart Upgrade Tracking Report will record the same message the user sees (Figure 5-15 on page 51) if the user manually initiated the process. To verify whether the Governor rejected the request, open the SmartUpgrade*.log attachment in the Tracking Report. If the rejection was caused by the Governor, there will be a log message that says:

TM=SUSmartUpgrade: SUBegin: error: Server error: Too many users are upgrading from this server. Try again later.
c. In the view, select the servers to include in the new cluster: Boston/ITSObank and LA/ITSObank.

d. Click **Add to Cluster**, then **Yes** to continue.
e. In the Cluster Name dialog, click **OK** to create a new cluster.

f. Type in the name of the new cluster (for example, **USCluster**), then click **OK**.

g. Select **Yes** to create the cluster immediately, and **OK** to the Request Successful dialog.

3. Check that the cluster has been created properly:
   a. Go to the **Files** tab in the Domino Administrator,
   b. Open the Cluster Directory database (**cldbdir.nsf**) on Boston server,
   c. Check that the Smart Upgrade database is listed with the same replica ID, and Enabled, for both servers in the cluster.

4. Create a Connection document for scheduled replication between the two clustered servers.

**Important:** The first time each Notes client connects to its Home/mail server after it has been added to a cluster, a cluster.ncf file is added to its \notes\data directory. This file contains the details required for the Notes client to connect to another cluster member in the event of a server outage on their home server. For clustering failover to work, the Notes client must have connected to its clustered home server at least once so that this file is created and updated with the current cluster information.
Notes client interaction

In this chapter we describe the final steps for Smart Upgrade to complete. We go through the validation process to make sure that the proper files are in place, see what happens in the background, and see what user interaction there is.

The topics covered in this chapter are:
- Validation of Smart Upgrade setup
- Behind the scenes
- User experience
- The final result
6.1 Validation of Smart Upgrade setup

To verify that Smart Upgrade is configured properly, we need to confirm that the database and kit document have been created correctly. On the Domino servers where the Smart Upgrade database is located, we must validate that:

- Smart Upgrade database is created.
- Smart Upgrade Kit document is created.
- Smart Upgrade database link is in the mail server’s Server Configuration document.

If enforcing the Smart Upgrade via a Policy and/or enabling the Smart Upgrade Tracking Reports database, we must validate that:

- Desktop Policy Settings document is created.
- Master Policy document is created.

We must also ensure the following requirements, which are necessary to deploy Smart Upgrade:

- Lotus Notes 6.0 or later client
- Lotus Domino 6.0 or later server
- User’s Location document correctly specifies their Home/mail server
- User has appropriate rights to install Lotus Notes on their machine

6.2 Behind the scenes

After the Smart Upgrade database has been created and correctly has a link in the Mail server’s Configuration document, the Notes client will perform the following steps:

1. The Notes client release number is compared with the release number specified in the Source version of the kit document in the Smart Upgrade database. The Notes client will send to the server its current version, platform, and localization.

   **Note:** Starting with Notes client and Domino 6.5.5, the InstallType parameter is also sent. This differentiates whether the setup is a Notes Client only or All Clients (Notes client, Admin client, Designer).

   You cannot use Smart Upgrade to upgrade a Notes Client only installation to an All Clients installation (or vice versa) on a workstation. If you want to change installation types, you must manually upgrade the client to the desired installation type.

2. The Smart Upgrade process on the server searches for a matching kit. If a match is found, a flag is sent back to the Notes client indicating that an upgrade kit might exist.

3. The Notes client searches the Smart Upgrade database for a match for its current Notes client version, platform, and localization. With Domino/Notes 6.5.5 or later, the Notes client also checks the installation type (set in the Install Type field in the kit document).

   **Important:** Smart Upgrade kits utilize a Readers field. Therefore, the Notes client only sees kits where they are specified in the Allowed Users and Servers field, or where this field is left blank.
4. Optional: If a Desktop Policy is in use and an upgrade kit release number is specified in the Deploy version, Notes compares this field to its version number. If the Deploy version is blank but an update kit is available, Smart Upgrade skips this step.

5. When a match is found, the Notes client displays a Smart Upgrade dialog box that prompts the user to upgrade their Notes client.

6. As Figure 6-1 and Figure 6-2 show, users can upgrade their clients immediately, or delay the upgrade for a specified amount of time.

![Smart Upgrade delay options when using an attached kit](image1)

![Smart Upgrade delay options when using a shared network drive](image2)

Figure 6-1  Smart Upgrade delay options when using an attached kit

Figure 6-2  Smart Upgrade delay options when using a shared network drive

a. If the user has a policy that specifies an upgrade deadline and that date has expired, the Smart Upgrade dialog displays an Update Now button that forces the user to update immediately. The user will not have the same delay options as above. Figure 6-3 on page 58 shows the dialog box when the time to upgrade the Notes client has expired.
b. If no deadline is set in a Desktop Policy Settings document to upgrade the Notes client by a specific date, users then have another option to wait for the next update as shown in Figure 6-4.

Note: In Notes client 6.5.1 and later, if the setting “Remind me every hour after “upgrade deadline” has passed” is set in the Desktop Settings document, users can delay the Smart Upgrade in one-hour increments before being prompted again.

If the Smart Upgrade Governor is in use
The Governor will only allow the concurrent execution of Smart Upgrades up to the Maximum Concurrent Downloads value specified in the server's Configuration document. If another request comes in to begin a Smart Upgrade and the Domino Server is already at its
maximum, the request will be rejected by the server. If the request was initiated manually on the Notes client (with File → Tools → Notes Smart Upgrade), a dialog box is displayed to the user, as shown in Figure 6-5. If the request was initiated automatically, no dialog is displayed to the user. The next upgrade attempt will be delayed one hour. For further information, refer to 5.4.2, “How the Smart Upgrade Governor works” on page 51.

![Smart Upgrade dialog box](image)

*Figure 6-5  Manual initiation response when Governor limit is reached*

When the Notes client completes the Smart Upgrade, it sends a message to the Domino server to decrement the current count of active upgrades in progress. Every hour, a small percentage of the active upgrade number will be reduced in case a Notes client fails to notify the Domino server. For more information about the Smart Upgrade Governor, refer to 5.4, “Limiting concurrent downloads with the Smart Upgrade Governor” on page 49.

**Smart Upgrade Database Intelligent Locator**

When building the servers in memory cache (beginning in Domino and Notes Client 6.5.4), if Smart Upgrade is using an attached kit in the Kit Document, the Notes client will use the closest Smart Upgrade database when downloading the attached kit.

### 6.3 User experience

After a Smart Upgrade database is created, allowed users start receiving automatic prompts to upgrade their clients when they re-authenticate with their Home/mail server. This will most likely not occur until the next day, when they log in.

**Tip:** A user can trigger Smart Upgrade to run manually at any time by selecting File → Tools → Notes Smart Upgrade.

**Dynamic Client Configuration**

The Dynamic Client Configuration (DCC) is a Notes client process that synchronizes certain information between Notes clients and Domino servers. The DCC executable, ndyncfg.exe, is located in the Notes client program directory.

DCC has several tasks and characteristics:

- DCC populates the Client Information section on the Administration tab of Person documents.
- DCC centrally manages Notes client information in the Client Location document, such as:
  - Internet address
  - Server fields in the Location document
- DCC is required for the proper operation of certain Domains processing, such as:
  - “Move Mailfile”
  - Roaming users
  - Policies
It is important to have DCC enabled to allow administrators to centrally manage user workstations. DCC is important specifically for Smart Upgrade if it is being pushed out through a Policy, if Smart Upgrade Tracking is set up, or both.

For more information about troubleshooting DCC issues, visit the IBM Lotus Knowledge Base at:
http://www.ibm.com/software/lotus/support

Important: DCC is important for Smart Upgrade only if Policies are being used to manage the Smart Upgrade process. The Smart Upgrade process itself is not initiated by DCC on the Notes client. Smart Upgrade has its own process for triggering a check.

6.3.1 The Smart Upgrade prompt

It is important to know (as described in Chapter 2, “Planning to upgrade the Notes clients” on page 7) which Client versions you will be upgrading from. Important new features have been added to Smart Upgrade since it was originally introduced in Lotus Notes and Domino 6.0. Refer to Table A-3 on page 68 for a full list of features that have been included in specific releases of the Notes client.

In particular, important differences between specific Notes client releases include:

- Prior to V6.5.3, the installation kit download process is a foreground process, so Notes client is unavailable while the download process is occurring.
- Beginning in V6.5.3, the installation kit download occurs as a background process, so users can continue working in the Notes client while downloading occurs. However, for Notes 6.5.3, 6.5.4, and 6.5.5 clients, after the Smart Upgrade download process has completed, the Notes client will automatically shut down without a notification.
- Beginning in V7.0, the Notes client prompts the user to begin the upgrade after the kit download process has completed and the installation package is ready to execute.

Version 6.0 - 6.5.2 clients

Beginning in Notes client 6.0, when downloading the kit document from either the Smart Upgrade database or shared drive, the installation kit download process is a foreground process, so the Notes client is unavailable while the download process is occurring. It is best to provide user education to explain that the Notes client will be in a locked state and give an estimate of how long the download process is likely to take.

Version 6.5.3 - 6.5.5 clients

Starting with the V6.5.3 Notes client, a background thread initiates the Smart Upgrade Kit download so that users will not be tied up. Figure 6-6 on page 61 shows the Notes client taskbar while the kit download is occurring. This is done in the background, enabling the user to work as normal.
However, when the download has been completed, the user will not receive a prompt of such.

If the user is not working in a document, the Notes client will automatically close without warning and begin the installation process. If the user is working in a document, specifically in a new memo, a warning message (Figure 6-7) appears.

If the user is working in any other document in a database, the warning in Figure 6-8 appears.

**Version 7.0 clients and later**
Beginning with the Notes client 7.0, after the kit has been downloaded in the background, users will be prompted to upgrade now. Figure 6-9 shows that the kit has finished downloading and the user is being prompted to begin the installation of the newer client.

If the user clicks No, the Smart Upgrade process can be resumed by manually using the menu option File → Tools → Notes Smart Upgrade. Alternatively, Smart Upgrade will restart on its own when Smart Upgrade checking next runs, after the interval set in the NOTES.INI parameters SU_NEXT_UPDATE and SUT_NEXT_UPDATE has passed.

*Tip:* When shutting down the Notes client after the kit has been downloaded locally, the Notes client cleans up the downloaded files. A user who wants to avoid downloading the kit again may either manually imitate Smart Upgrade or leave the Notes client running so the next time Smart Upgrade runs, it will recognize the downloaded kit.

**Silent install progress bar**
Most administrators use some of the optional arguments when configuring Smart Upgrade. The /qb+ switch is the most common, and this shows a progress bar indicating the status of
the installation with a modal dialog box displayed at the end to notify that the installation was completed.

**Tip:** For more information about optional arguments, refer to 4.4, “Using optional arguments when running Smart Upgrade” on page 29.

Figure 6-10 shows what the progress bar looks like as the installation is done in the background.

![Progress bar of client installation](image)

*Figure 6-10  Progress bar of client installation*

Administrators can prevent users from exiting an installation in progress by using `qb+!` or `qb+!` to hide the Cancel button. For more optional command line arguments, see Table 4-4 on page 30. Figure 6-11 shows a dialog box with the Cancel button hidden.

![Progress bar of client installation without the Cancel button](image)

*Figure 6-11  Progress bar of client installation without the Cancel button*

Figure 6-12 shows a dialog box that displays after the upgrade was successful.

![Successful upgrade notice](image)

*Figure 6-12  Successful upgrade notice*
6.4 The final result

After the kit has downloaded locally (optional) and the Notes client installation and the Notes client have restarted, in most cases users will see the dialog shown in Figure 6-13, prior to the Notes password prompt.

![Completion of Notes setup](image)

Figure 6-13 Completion of Notes setup

If Policies are configured for the Smart Upgrade Tracking reports, a report will be sent to the Domino server to help administrators track the clients that have been upgraded successfully.

Figure 6-14 shows a tracking report in which the client successfully upgraded.

![Smart Upgrade Report - Succeeded](image)

Figure 6-14 Tracking report of a successful upgrade

For further information about the content of Smart Upgrade Tracking Reports, see 5.3.1, “The Smart Upgrade Tracking Reports database” on page 42.
Choosing the correct installation package to use with Smart Upgrade can be a daunting task. Administrators not only must be aware of the client versions running on their users’ workstations, they also need to understand the difference between the various downloadable and CD installation packages.

This appendix provides a wealth of information about how to choose the correct package to use with Smart Upgrade to ensure that administrators can easily and correctly match the most efficient and effective installation package to each section of their user population.

The topics covered in this appendix are:
- Definition of a Smart Upgrade kit
- Which kit do I use?
- Where to obtain the Lotus Notes Installation Packages
- How to unpack a kit obtained from the IBM Web site
- Using a Cumulative Client Hotfix with Smart Upgrade
- Considerations for non-English clients
Definition of a Smart Upgrade kit

The terms *Smart Upgrade kit* and *Web kit* refer to any of the packaged single executable files that are available on the IBM Support Web site and Passport Advantage for Lotus Notes client upgrades.

**Tip:** There is no single entity called “Smart Upgrade Kit” or “Web Kit.” Several different installation kits can be used with Smart Upgrade, and these are described in this appendix.

Kit naming convention

Each downloadable Notes client installation kit is named using the same naming convention. Figure A-1 describes the naming convention, using the Notes client 7.0.1 full installation package as an example.

<table>
<thead>
<tr>
<th>The client type:</th>
<th>Version details:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notes client, or Notes, Designer, Admin clients</td>
<td>Shows a single version number for full and upgrade kits, or a From and To version for patch kits</td>
</tr>
</tbody>
</table>

**Platforms**

- IBM Lotus Notes Client 7.0.1 for Windows 2000, XP Pro and XP Tablet PC Edition English (C880CNA)

**Language**

**Part number:**
(also the file name of the executable)

*Figure A-1  Lotus Notes Kit naming convention*

Notes Client upgrade kits and patch kits are similarly named, as shown in the Patch Kit example in Figure A-2.

*Figure A-2  Lotus Notes Kit naming example: Upgrade Kit and Patch Kit*
Three basic kit types are available for download (Table A-1).

<table>
<thead>
<tr>
<th>Kit name</th>
<th>Usage</th>
<th>Additional information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notes Client (also known as the Full Client Install)</td>
<td>Use with Smart Upgrade to upgrade clients to a new major version (for example, from 6.5.x to 7.0.x).</td>
<td>This kit can also be used to install Lotus Notes on a clean workstation, but this cannot be done using Smart Upgrade.</td>
</tr>
<tr>
<td>Notes Client Upgrade Kit</td>
<td>Use to upgrade from any point release to another within a major release (for example, from 7.0 to 7.0.2, or from 6.5.1 to 6.5.5).</td>
<td>An upgrade kit cannot be used to upgrade from one major release to another; for example, the Upgrade Kit for 7.0.1 will not upgrade a 6.5.x client.</td>
</tr>
<tr>
<td>Notes Client Patch Kit</td>
<td>Use to upgrade from and to a specific point release only (for example, from 7.0 to 7.0.1).</td>
<td>The From and To version details are specified in the name of the downloadable kit.</td>
</tr>
</tbody>
</table>

Note: Each of these kit types is also available in a Notes, Designer, Admin Clients (“All Clients”) package. These can also be used with Smart Upgrade.

**Which kit do I use?**

The kit or kits that you use depends on a number of factors, including:

- Attached kit or shared network drive
  - An installation package can be attached to a Smart Upgrade Kit document, or made available on a network drive and referred to in the Smart Upgrade Kit document.
- From and To versions
  - The various kit types provide different options for upgrading.
- Version-specific requirements
  - Some of the features that are now available in Smart Upgrade were not available in earlier versions of the Notes client. Extra planning is recommended if you plan to upgrade from earlier 6.0.x and 6.5.x clients.

**Attached kit or shared network drive**

During Smart Upgrade configuration, you may choose to store the Lotus Notes client installation files either as an attachment in the Smart Upgrade Kit document or on a shared network drive (or both).

To store the files on a shared network drive, the shared location is referenced in the Smart Upgrade Kit document. Any of the available installation packages can be used for this purpose: kits obtained from the IBM Web site or installation files from the Lotus Notes and Domino Product CDs. See “Where to obtain the Lotus Notes Installation Packages” on page 70 for further information about obtaining kits.
Tip: To use a kit from the IBM Web site on a shared network drive, we recommend unpacking the kit first. Although this is not essential, using an unpacked kit results in a lower disk space requirement on the users’ workstations. Using a packed kit requires enough disk space on each workstation to unpack the kit to the user’s TEMP directory prior to installation. See “How to unpack a kit obtained from the IBM Web site” on page 71 for further information about unpacking kits.

Source and destination versions

Each of the three basic kit types differs in size and in the versions it can be used to upgrade. Table A-2 describes the basic benefits of each type.

Table A-2 Advantages and disadvantages of Notes client kit types

<table>
<thead>
<tr>
<th>Kit name</th>
<th>Advantage</th>
<th>Disadvantage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notes Client (Full client install)</td>
<td>This is the most flexible kit: can be used to upgrade any 6.0.x, 6.5.x, or 7.0.x Notes client to the latest point release.</td>
<td>Has the largest file size, resulting in slowest download and highest network bandwidth usage.</td>
</tr>
</tbody>
</table>
| Notes Client Upgrade Kit        | ▶ Smaller file size than the Notes Client Kit, resulting in faster download and lower network bandwidth usage.  
                                 | ▶ Can upgrade any point release within a major release version.     | Cannot upgrade to a new major version.                            |
| Notes Client Patch Kit          | Much smaller file size than Notes Client and Notes Client Upgrade kits, so this kit has the fastest download and lowest network bandwidth usage. | Only upgrades from and to a specific point release; far more limited. |

Version-specific requirements

Smart Upgrade was introduced in Lotus Notes and Domino 6. Since that time, new features have been introduced. To upgrade older V6.x client versions, it is wise to be aware of the Notes client version dependencies for these features.

Table A-3 lists the feature dependencies and suggested actions. This table assumes a Version 7.0.1 Domino Server, Domino Directory, and Smart Upgrade template.

Table A-3 Notes client version dependences for Smart Upgrade

<table>
<thead>
<tr>
<th>Feature</th>
<th>Minimum client version</th>
<th>Suggested actions for earlier versions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiple source versions supported</td>
<td>6.0.3/6.5</td>
<td>Create a separate Smart Upgrade Kit document for each client source version that requires upgrading</td>
</tr>
</tbody>
</table>
### Appendix A. Understanding Smart Upgrade kits

<table>
<thead>
<tr>
<th>Feature</th>
<th>Minimum client version</th>
<th>Suggested actions for earlier versions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pattern matching for source versions</td>
<td>6.5.1</td>
<td>To specify multiple pre-6.5.1 source versions in one document, use the asterisk wildcard. If more specific source version control is required, a separate Smart Upgrade Kit document must be created for each pre-6.5.1 source version requiring upgrade. In this case, each Kit Document would have to specify the complete source version string.</td>
</tr>
<tr>
<td>Upgrade Deadline enhancement: Remind me every hour</td>
<td>6.5.1</td>
<td>This feature only affects organizations that use Policies to enforce a Smart Upgrade deadline. Pre-6.5.1 clients ignore the Upgrade Deadline settings. Check the users’ Person documents in the Domino Directory to determine which users have not completed the upgrade process (Administration tab). For users who have not completed the upgrade, extra communication or assistance might be required to help them complete the process manually (using File → Tools → Notes Smart Upgrade).</td>
</tr>
<tr>
<td>Notes client will fail over when attempting to find Smart Upgrade database and the user's home server is down, but a cluster mate containing a replica of the Smart Upgrade database is available</td>
<td>6.5.1</td>
<td>If a pre-6.5.1 user's home server is unreachable when Smart Upgrade checking is performed, the process will fail silently. Smart Upgrade will then be set to the next check interval (normally one day). Smart Upgrade will proceed normally at the next check interval if the home server becomes available by that time. Alternatively, users could complete the process manually (using File → Tools → Notes Smart Upgrade).</td>
</tr>
<tr>
<td>Administrator can specify both a shared path and an attached kit</td>
<td>6.0.4/6.5.2</td>
<td>If there are pre-6.0.4/6.5.2 clients in the environment, the simplest way to ensure that all clients can reach the upgrade kit file is to create a Smart Upgrade Kit document with an attached kit only.</td>
</tr>
<tr>
<td>Background thread initiates Smart Upgrade (kit downloads in the background)</td>
<td>6.5.3</td>
<td>Prior to the addition of this feature, the Notes client was tied up while the download was occurring. Provide user education to explain what the process will look like, and how long the download process is likely to take.</td>
</tr>
<tr>
<td>Smart Upgrade Tracking Reports and the SmartUpgrade*.log on the client</td>
<td>6.5.3</td>
<td>Check the users’ Person documents in the Domino Directory to determine which users have not completed the upgrade process (Administration Tab).</td>
</tr>
</tbody>
</table>
### Where to obtain the Lotus Notes Installation Packages

There are two ways to obtain the Lotus Notes Installation Packages for use with Smart Upgrade:

- **Original Lotus Notes and Domino Product CDs ("Yellow CDs")**
  
  These CDs contain only the unpacked installation files, so can only be used with the Smart Upgrade Kit Document location option on a *shared network drive*.

- **Downloaded from the Internet**

  There are two options for downloading Lotus Notes installation packages that can be used with Smart Upgrade. The options are:
  
    
    This Web site contains Client Upgrade kits and Client Patch kits for both the Lotus Notes client and all clients (the Notes, Designer, Admin Clients kit). This Web site does not contain Full Client Install kits.
– Passport Advantage Web site

This Web site contains all three types of Lotus Notes installation packages (Full Client Install kits, Client Upgrade kits, and Client Patch kits).

**Note:** To access this Web site, you must have a valid Passport Advantage user name and password.

Passport Advantage Online:

https://www.ibm.com/software/howtobuy/passportadvantage/paocustomer

To find out more about accessing Passport Advantage Online:


---

**How to unpack a kit obtained from the IBM Web site**

All Notes client software downloaded from the IBM Support Web site and Passport Advantage is packaged as a single executable “packed” file.

These single executable files are designed for use with Smart Upgrade. The file can be attached as-is into Smart Upgrade Kit documents.

To use Smart Upgrade with the installation files on a shared network drive, it is recommended that the single executable file be unpacked for use with Smart Upgrade. This is how:

1. On a Windows workstation, run the executable file obtained from the IBM Web site.

   ![Figure A-3 Running a kit executable file](image)

2. In the InstallShield Wizard dialog box, select or type a location for the unpacked files, for example: `c:\Temp\Lotus Notes`.

   ![Figure A-4 Choosing a file location](image)
3. Click **Next** and allow the installation process to unpack the files. At the next prompt, choose **Cancel**.

4. The unpacked installation files will now be available in the location you specified (c:\Temp\Lotus Notes, in this example). Copy the files to the shared network drive.

**Using a Cumulative Client Hotfix with Smart Upgrade**

A Cumulative Client Hotfix (CCH) is a bundle of hotfixes for the Lotus Notes client. Cumulative Client Hotfixes are provided to individual customers by IBM Support when an issue that a customer logs as a Problem Management Report (PMR) is specifically identified as being fixed in a Cumulative Client Hotfix. These packages are not available for general distribution or download.

The Cumulative Client Hotfix Installer is packaged as a single executable, which can be used with Smart Upgrade either as an attached kit or on a network drive.
Considerations for non-English clients

New to Lotus Notes 7.0, is the availability of Notes Client Upgrade kits and Notes Client Patch kits for all language versions. These can be used with Smart Upgrade to upgrade non-English Notes clients.

The Smart Upgrade process checks the installed Notes client version against the Localization field in the Smart Upgrade Kit document.

**Important:** When attaching the kit to a Smart Upgrade Kit document, make sure that the Localization field matches the language version of the kit that is attached. The Localization field is only compared with the language of the installed client—it is not compared with the language of the attached kit.

The Allowed Users & Servers field of the Smart Upgrade Kit document does not necessarily have to be used to limit access to this kit. When the Localization field is correctly set to match the language version of the attached kit, the Smart Upgrade process will take care of determining which clients match the language version for this upgrade.

---

**Note:** If you are using a Cumulative Client Hotfix on a network drive, this kit should not be unpacked; simply copy the single executable file to the shared network drive and refer to that location in the corresponding Smart Upgrade Kit document.
Troubleshooting basics

This appendix provides information for dealing with common errors and configuration issues that might affect the Smart Upgrade process. The sections are organized to provide administrators with a clear understanding of how the Smart Upgrade components fit together, the troubleshooting tools that are available, and examples of the most common problems.

The topics covered in this appendix are:

- **Smart Upgrade components**
  A basic understanding of the Smart Upgrade components is the first step to understanding how to effectively troubleshoot issues.

- **Smart Upgrade troubleshooting tools**
  Discusses the administrator’s Smart Upgrade troubleshooting “toolkit,” the best tools to use for troubleshooting Smart Upgrade.

- **Common problems and solutions**
  A discussion of the most common problems encountered with Smart Upgrade, what to check, and how to resolve them.
Introduction to Smart Upgrade troubleshooting

Smart Upgrade was introduced in Notes/Domino 6, and since its introduction has been widely adopted by the Lotus Notes and Domino community as the preferred method of upgrading Notes clients. Consequently, Smart Upgrade has been used successfully in a wide variety of customer configurations and implementation scenarios.

Experience with using Smart Upgrade and with troubleshooting issues has shown that there is invariably a logical explanation for Smart Upgrade not initiating or completing successfully. The most important point to remember is that Smart Upgrade configuration requires very precise and careful planning and implementation. Carefully checking and re-checking each component involved in the Smart Upgrade process is enough in most cases to discover the cause of issues and to resolve them when they occur.

The tools and common problems discussed in this appendix are designed to arm administrators with the tools and knowledge to understand the logical explanation behind any Smart Upgrade issue that might arise.

Smart Upgrade components

The Smart Upgrade components interact to make Smart Upgrade function properly. Understanding each of these components is the first step to learning where to go when problems arise.

Table B-1 describes the basic components of Smart Upgrade.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
<th>Interaction with Smart Upgrade</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smart Upgrade database</td>
<td>This database contains the Smart Upgrade Kit documents, which are the heart of Smart Upgrade.</td>
<td>▶ Controls which Notes clients will be upgraded, by setting source and destination versions, operating system, client install type, localization, and allowed access fields. ▶ Controls the user experience during upgrade, using optional arguments for setting interaction and restart settings. ▶ Contains the install kit as an attachment or a linked network location.</td>
</tr>
<tr>
<td>Notes client installation kits/files</td>
<td>These are the actual installation packaged kits or files that are used to upgrade the Notes client with Smart Upgrade.</td>
<td>These kits are attached to the kit documents in the Smart Upgrade database, or placed on a shared network drive and referenced in the Kit documents.</td>
</tr>
<tr>
<td>Component</td>
<td>Description</td>
<td>Interaction with Smart Upgrade</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Server Configuration document</td>
<td>Kept in the Domino Directory for the organization, Server Configuration documents store configuration settings that are relevant to the Domino servers.</td>
<td>The Server Configuration document:&lt;br&gt;► Stores the database link used by the Notes client to find the Smart Upgrade database.&lt;br&gt;► Contains the Smart Upgrade Governor settings to specify maximum concurrent Smart Upgrade downloads.</td>
</tr>
<tr>
<td>Notes client</td>
<td>Initiates the Smart Upgrade process to check for new versions of the client.</td>
<td>Several components on the Notes client interact with Smart Upgrade:&lt;br&gt;► The notes.ini file contains localization and install-type settings that are used to find a matching Smart Upgrade Kit document. Also contains settings to control the checking interval and other Smart Upgrade parameters.&lt;br&gt;► The Dynamic Client Configuration process copies any Policy and Policy Settings documents to the client (which may be used to manage Smart Upgrade).&lt;br&gt;► The local address book (names.nsf) stores Policy and Policy Settings documents which may be used to control Smart Upgrade. The Location document stores the Home/mail server and Domino directory server information used by the client to find the Smart Upgrade database.</td>
</tr>
<tr>
<td>Policy and Policy Settings documents</td>
<td>Provide administrators with centralized control over user and Notes client configurations.</td>
<td>Can be optionally used to manage Smart Upgrade:&lt;br&gt;► Destination version and upgrade deadline&lt;br&gt;► Collection of Smart Upgrade Tracking Reports</td>
</tr>
</tbody>
</table>
Smart Upgrade troubleshooting tools

Troubleshooting Smart Upgrade need not be a daunting experience for the Domino administrator. Several tools are available to help logically work through possible issues.

The most useful troubleshooting tools for Smart Upgrade are:

- **Smart Upgrade Tracking Reports database**
  
  This is the first place to check the status of Notes client upgrades. Cancelled and Failed Smart Upgrade attempts will usually be reported here, along with error messages and other useful information. For more information, see 5.3.1, “The Smart Upgrade Tracking Reports database” on page 42.

- **Smart Upgrade log file**

  Starting in Notes 6.5.3, the Smart Upgrade process creates a log file on the Notes client workstation each time it runs. This log file contains the configuration information used by the Smart Upgrade process, and the output and results from the Smart Upgrade attempt. This information is used to build each Smart Upgrade Tracking Report. The file can be viewed either directly on the workstation or from the attachment in the Tracking Report. For more information, see 5.3.2, “Smart Upgrade logging on the Notes client” on page 47.

  **Note:** The SmartUpgrade*.log files are usually the first thing that Lotus Support will ask for you to send in the event of a Smart Upgrade issue. It is worthwhile to gather these and have them ready to send if you log a PMR for a Smart Upgrade issue.

- **lotusinstall.log file**

  This is created for all Notes client installations (not just those which use Smart Upgrade) and contains details about the installation process, such as errors, failures or successful installations. It can be viewed directly on the client, or from the attachment in the Smart Upgrade Tracking Report. For further information, see 5.3.2, “Smart Upgrade logging on the Notes client” on page 47.

- **Notes client notes.ini file**

  The notes.ini file contains two types of settings of interest to troubleshooting:

  1. Settings used to determine a matching Smart Upgrade Kit document: localization, MUI (multi-user interface), and installation type.

  2. Settings used to control the Smart Upgrade process on the client: Last known location of the Smart Upgrade database (Domino server and replica ID), mail server, and Smart Upgrade intervals (next check due, Smart Upgrade in progress, any version delays set, location of temporary download for the kit files).
“($Policies)" view of the Notes client address book (names.nsf)

If Policies are in use for managing Smart Upgrade, use this view to ensure that the latest Policy and Desktop Settings document has been downloaded to the client.

---

**Debug settings**

The notes.ini setting `Debug_Smart_Upgrade=1` can be used on either the Domino server or Notes client to record additional information about the Smart Upgrade process. Figure B-1 shows an example of the output from this debug setting.

**Important:** This debug setting might have a negative performance impact on the server or client. We recommend using this setting only as a last resort, because most of the information generated by the setting is also recorded in the Smart Upgrade log and Tracking Reports. It is useful on earlier Notes 6.x version servers and clients because Smart Upgrade log files and Tracking Reports are not generated for these versions. Also, it might be useful in situations where the next update settings in the notes.ini are being forward-dated, but the Smart Upgrade process is not initiating at all.

---

**Common problems and solutions**

This section discusses the most common problems and errors that might be encountered using Smart Upgrade and how these can be resolved. We organize problems by the main symptom or issue, then discuss possible causes and solutions for each.

---

**User is not being prompted to Smart Upgrade**

The usual symptom of this problem is that users are not being prompted to Smart Upgrade their Notes client. A user invoking Smart Upgrade manually (using File → Tools → Notes Smart Upgrade) receives a response stating that no updates are available (Figure B-2). Other error messages will be displayed depending on the root cause of the problem.

---

Silent failure is perhaps the most common issue experienced with Smart Upgrade, and is where careful checking of each component of Smart Upgrade is most vital. This issue might be caused by misconfiguration within almost any of the components that interact with the Smart Upgrade process.
There are two possible problem scenarios for this issue:

- **Problem 1: Smart Upgrade parameters in notes.ini are updated, but the user is never prompted to upgrade.**
- **Problem 2: Smart Upgrade parameters in notes.ini do not get updated properly and the user never is prompted to upgrade.**

**Problem 1: Smart Upgrade parameters in notes.ini are updated, but the user is never prompted to upgrade**

To the administrator checking this problem, it may appear as if Smart Upgrade never runs because the client's notes.ini parameter SU_NEXT_UPDATE always appears to be reset to a future date (usually one day in the future). This is not the case: if the SU_NEXT_UPDATE setting is being updated, it indicates that Smart Upgrade checking has occurred but no upgrade process was invoked. When Smart Upgrade checking on the Notes client results in no upgrade process being invoked, the user is not prompted to advise them of that fact. This occurs by design, to avoid unnecessary prompting when no kits are available or reachable for that Notes client.

This can occur for a number of different reasons:

- The Smart Update process on the client was unable to find the Smart Upgrade database on the server:
  - Check the Server Configuration document: Be sure that the link to the Smart Upgrade database for the user's home server (Smart Upgrade tab) is valid.
  - Check the Notes client: Ensure that the user can connect to the server containing the Smart Upgrade database, can open the database, and can open the kit document you intended for them to use.
  - Check the Notes client address book (names.nsf): In the current Location document, check the user's Home/mail server field (Servers tab) is correct. If the Smart Upgrade database link is in a *-[Default] Configuration document, ensure that the Domino directory Server field (Servers tab) is also correctly set and that the user can connect to both the directory server and the server containing the Smart Upgrade database.

**Note:** The Home/mail server field must be set, even for users who do not use Notes mail. We also strongly recommend setting the Domino Directory Server field.

- Try running Smart Upgrade manually from the Notes client (File → Tools → Notes Smart Upgrade). A displayed error dialog might provide further clues about the cause.

**Note:** If only a *-[Default] Configuration document is in use (that is, there is no Smart Upgrade database link in the Configuration document for the user's mail server), the user will not be prompted automatically to Smart Upgrade when their mail server is unreachable. In this situation, the user can manually invoke the Smart Upgrade process, or wait until the next automatic checking occurs (when the mail server is running again). For the manually invoked process to work while the user's mail server is down, the Domino directory server field must be set to a server that is reachable by the Notes client.

- The Smart Upgrade Kit document specifies a network path for the kit but the network path is not valid (or the user does not have access to it):
  - Check the Smart Upgrade Tracking Reports or SmartUpgrade*.log file: This error will display in the Tracking Report sent by the Notes client after the failure occurs, so this is
the first place to check. The report will be of type “Failed”. If Tracking Reports are not in use, check the SmartUpgrade*.log file on the Notes client. The error is:

The shared network kit path: ‘<Network Path>’ configured in the Smart Upgrade database smupgrade.nsf on <ServerName> is not accessible.

– Try running Smart Upgrade manually from the Notes client (File → Tools → Notes Smart Upgrade). If this is the cause of the problem, the same error dialog will be displayed.

– The user does not have Reader access to the Smart Upgrade Kit document.

Check the Smart Upgrade Kit document: If the Allowed Users & Servers field (Administration tab) has been filled in, it must then contain the user name or a group name of which the user is a member.

**Tip:** If the Allowed Users & Servers field is empty, this is not the cause of the problem, because an empty field means that all users and servers can read this document.

– Source version field in the Smart Upgrade kit document is not correctly specified.

The Source version field in the Smart Upgrade Kit document must exactly match the Notes client's source version, either using the exact text or pattern matching.

– Check the source version of the Notes client. This can be displayed on the Notes client (Figure B-3) by choosing **Help → About Notes**.

**Figure B-3**  The Notes client source version (**Help → About Notes**)

**Important:** For Notes client versions earlier than 6.5.1, the asterisk (*) is the only accepted wildcard. In most instances, the asterisk wildcard provides sufficient functionality to minimize the administration overhead of kit creation. See 4.3, “Smart Upgrade pattern matching” on page 28 for more about advanced pattern matching strings.

– Destination version for the Smart Upgrade Kit does not match Deploy version in the Desktop Policy Settings.

If Smart Upgrade in being managed using Policies, the Destination version field in the Smart Upgrade kit document must exactly match the text of the Deploy version field in the Desktop Settings document (Smart Upgrade tab). If these do not match exactly, the Smart
Understanding Lotus Notes Smart Upgrade

Upgrade process will run but will find no kits available for the user. Running Smart Upgrade manually from the Notes client (File → Tools → Notes Smart Upgrade) will result in the “no updates available” dialog.

- Check that the Destination version field in the Smart Upgrade kit document exactly matches the text in the Deploy version field in the Desktop Settings document (“Smart Upgrade” tab).

For further information, see 5.2, “Configuring policies to assist with Smart Upgrade management” on page 38.

- Location Document on the Notes client does not specify the full hierarchical Domino server name.

The Home/mail server field of the Location document must contain the full hierarchical name of the user's mail server; otherwise, prompting might not occur.

For example:
Correct: Boston/ITS0bank
Incorrect: Boston

- InstallType= parameter in the notes.ini on the Notes client is incorrect.

Smart Upgrade kit documents created for Notes clients 6.5.4/6.0.5 and greater have the client installation type set using the Install Type field. This is set in each kit document to match the installation files in that document (either Notes client or All client).

During Smart Upgrade checking on the client, the setting in this field checks against the InstallType= parameter in the notes.ini file on the client to determine whether the kit is a match. Possible values in the notes.ini are:
- InstallType=2   (All Client)
- InstallType=6   (Notes Client only)

Check notes.ini on the Notes client to ensure that this parameter is set correctly. Sometimes this parameter is incorrect, causing the Smart Upgrade process to determine that no matching kits exist for that client.

- Smart Upgrade configuration has changed recently, but old settings are still cached on the Domino server.

If Smart Upgrade configuration in the Domino Directory or Smart Upgrade database is changed, the new settings might not be cached immediately on the server.

- Type sucache refresh at the Domino server console to force Smart Upgrade to update its cache and use the latest configuration settings.

Problem 2: Smart Upgrade parameters in notes.ini are not properly updated and the user is never prompted to upgrade

Smart Upgrade uses a background authentication process to initiate Smart Upgrade checking. This means that even when users just open their Notes client and do not manually initiate authentication with their home server (for example, by opening or replicating a database), Smart Upgrade checking will still occur. It is possible for this process to stop working on a Notes client, and this problem can occur in three different problem scenarios:

- Notes clients prior to 6.0.5/6.5.4: Manual initiation of Smart Upgrade might be required.

- Smart Upgrade checking does not start automatically on any 6.x client; forced/manual authentication might be required

- Home/mail server cannot connect to server containing Smart Upgrade database
To determine whether background Smart Upgrade checking is occurring:

1. Open the Notes client.
2. Ensure that no databases or replication are set to occur automatically on startup (including Welcome pages that open the mail file on the server).
3. Close the Notes client.
4. Open the notes.ini file.
5. Search for the SU_NEXT_UPDATE and SUT_NEXT_UPDATE lines.
6. If these lines exist, remove them or set them to a past date value.
7. Open the Notes client but do not open any databases (or initiate replication).
8. Watch the status bar; after about 25 to 30 seconds the status bar will show that the Notes client is connecting to the home/mail server (Figure B-4).

Figure B-4  Status bar showing Smart Upgrade checking occurring

If this does not happen, background Smart Upgrade checking is not occurring.

**Tip:** Another way to determine whether automatic background checking has occurred is to delete all of the lines in notes.ini beginning with SU and SmartUpgrade, then run this test. After running the test, reopen notes.ini. If automatic checking has not occurred, the lines beginning with SmartUpgrade will be missing.

**Notes clients prior to 6.0.5/6.5.4: Manual initiation of Smart Upgrade might be required**

In Notes client versions prior to 6.0.5/6.5.4, the user might need to force an authentication with their home server for Smart Upgrade checking to occur. **Forced authentication** means actually opening a database on the home server. For users who do not use Notes mail, or who always use a local mail file replica, it is possible for Smart Upgrade checking to never occur.

Check the users’ Person documents in the Domino Directory to determine which users have not completed the upgrade process (Administration tab).

Alternatively, check the Notes client's notes.ini file for lines beginning with SmartUpgrade. If Smart Upgrade is not being invoked, these lines will be missing.

Smart Upgrade might require manual initiation (File → Tools → Notes Smart Upgrade) for these earlier Notes clients.

**Smart Upgrade checking does not start automatically on any 6.x client**

Forced/manual authentication might be required. This issue can occur in any 6.x version client. The symptom is that the authentication and automatic background checking do not occur, but if the user opens a database or initiates replication with the home server (causing a manual/forced authentication), the Smart Upgrade checking occurs then.

Users normally would not notice this issue, because most users authenticate with their home server for mail access, replication, or mail addressing. This issue could affect only users who do not use Notes mail and do not access their home/mail server for any other reason.
This is a rare situation. For users who do not use Notes mail and do not access the server for any other purpose, there are a couple of workaround options:

- If there is a database that all users access automatically at Notes client startup (for example, the bookmark database), create a post-open command that does something that requires authentication with the home/mail server
- or
- If there is another database that all users access on a different server, create a post-open command in that database that does something that requires authentication with the home/mail server.

**Note:** These workarounds assume that the Home/mail server field in the Notes client's Location document has been set correctly.

**Tip:** The authentication with the user's home server will occur automatically only if the user's Home/mail server field is set in the current Location document on the client. The Directory Server field should also be set, if a * - [Default] Configuration document is in use for the Smart Upgrade database link. These Location document fields are required even for users who do not use Notes mail. Be sure that these fields are populated correctly before assuming that automatic Smart Upgrade checking is not occurring.

**Home/mail server cannot connect to server containing Smart Upgrade database**

For Smart Upgrade to function where there is a * - [Default] Configuration document in use, both the Notes client and their home mail server must be able to connect to the server containing the Smart Upgrade database (the server referenced in the * - [Default] configuration).

If the user's mail server cannot connect to the Smart Upgrade server, the Smart Upgrade configuration settings will not be loaded on the server, and Smart Upgrade background checking will not occur on the Notes clients.

In this situation, manually invoking Smart Upgrade checking on the client will also fail.

This is easy to check:
- Type `sucache show` at the server console of the mail server. If this problem exists, the response returned will be *Smart Upgrade is presently not configured on server <servername>*.
- Type a command that will force the mail server to connect to the Smart Upgrade server (for example, `repl SUServername names`).
- If the server cannot connect using this command, fix this problem first, then type `sucache refresh` at the mail server console to load the Smart Upgrade configuration.

**User receives “server not responding” error when running Smart Upgrade manually**

When the user runs Smart Upgrade manually (File → Tools → Notes Smart Upgrade), an error might appear, indicating that their home server is not responding (Figure B-5 on page 85).
Appendix B. Troubleshooting basics

Figure B-5  Smart Upgrade “server not responding” error

This error means that the user’s home server is unreachable and Smart Upgrade cannot find any alternative servers to use.

Smart Upgrade can be configured so that if a user’s home server is unreachable, the client can find Smart Upgrade database replicas on other Domino servers in the domain. If the user is receiving a message stating that their home server is not responding, this indicates that the configuration required to find a Smart Upgrade replica on an alternative server has not been instated.

There are two options for providing alternative servers for Smart Upgrade:

1. Use Domino clustering for the mail server, and put Smart Upgrade database replicas on all servers in the cluster. For further information, see 5.5.1, “How to enable clustering awareness for Smart Upgrade” on page 52.

2. Add the Smart Upgrade database link to the “* - [Default]” Configuration document (Smart Upgrade tab) in the Domino Directory. For further information, see 3.3, “Defining the Smart Upgrade database in the server’s Configuration document” on page 19.

Tip: If the * - [Default] Configuration document has been set up correctly but Smart Upgrade checking still results in the “server not responding” error, check the user’s current Location document. The Home/mail server field must specify a home server for the user (even if the user does not use Notes mail) and the Domino directory server field must correctly specify an available Domino server for Smart Upgrade to find the Configuration document.

User receives “Unable to locate your mail server” error when running Smart Upgrade manually

This issue, shown in Figure B-6, most often occurs for users who do not use Notes mail. The error indicates that the Home/mail server field in the user’s current Location document on the Notes client has not been set.

Figure B-6  “No mail server” error

- Edit the current Location document on the Notes client. On the Servers tab, fill in the Home/mail server field with the correct server name. For users who do not use Notes mail, this must be a server for which a Configuration document containing the Smart Upgrade database link exists (or where the * - [Default] Configuration doc can be reached).
Smart Upgrade should be silent, but is not

Smart Upgrade can be configured so that the installation process does not require user interaction (silent upgrade). The command line switches added to the Optional arguments field of the Smart Upgrade document must be planned and implemented carefully. The upgrade will not be silent if there is any error in the command line switches added to this field.

- See 4.4, “Using optional arguments when running Smart Upgrade” on page 29 in its entirety to understand the optional switches that are required for each circumstance. This section also contains examples of common scenarios and the required switches for each.

User does not have Administrator rights to workstation

The Notes client installation process requires the user to have Administrator rights to the operating system on the workstation. By definition, because Smart Upgrade uses Notes client installation kits, it also requires the user to have Administrator rights on the workstation.

If the user does not have Administrator rights on the workstation, the Smart Upgrade will still be invoked, but when the user clicks Yes to begin the installation, nothing will happen.

It might be possible for power users to work around this issue. For further information, refer to Technote 1199690, “Smart Upgrade works only with an Administrator account” at:

http://www.ibm.com/support/docview.wss?rs=899&uid=swg21199690

Attention: Lotus Notes and Domino 7.0.2 have a new feature called Run As Admin (SURunAs), which provides the ability to use Smart Upgrade to upgrade Notes clients where the user does not have Administrator rights to the workstation. For more information, see Appendix C, “Sneak preview: Smart Upgrade “Run As Admin” utility” on page 91.

Smart Upgrade Tracking Reports are not being sent to the Reports database

Smart Upgrade Tracking Reports was a new feature added to Lotus Notes and Domino 6.5.3. Both the Domino Server and Notes client must be at V6.5.3 or later for tracking reports to be sent to the mail-in database.

If V6.5.3 or later clients are not sending tracking reports to the database:

- Check that the Tracking Reports database has been configured correctly in the Desktop Settings document in the Domino Directory.

- Confirm that the Mail-in Database document for the Tracking Reports database is correctly configured.

Note: If the user is using a local mail file, the Tracking Report will sit in the local mail.box until the next Send new mail interval. In this case, there may be a delay before the Tracking Report is received into the database.

For more information about enabling Smart Upgrade Tracking Reports, see 5.3.1, “The Smart Upgrade Tracking Reports database” on page 42. For information about alternative tracking
mechanisms that can be used for earlier Notes client versions, see 5.3, “Tracking Smart Upgrade results” on page 42.

The Smart Upgrade Governor does not seem to be limiting the number of concurrent upgrades

The Smart Upgrade Governor feature was introduced in Lotus Notes and Domino 6.0.5/6.5.4.

This problem can occur in two different problem scenarios:

- Pre-6.0.5/6.5.4 clients not being limited by the Governor
- Version 6.0.5/6.5.4 and later clients not being limited by the Governor

Pre-6.0.5/6.5.4 clients not being limited by the Governor

Both the Domino Server and the Notes client must at Version 6.0.5/6.5.4 or later for the Smart Upgrade Governor to limit concurrent upgrades. For organizations with a mix of client versions, only the newer (6.0.5/6.5.4 and later) clients will observe the Governor limits. In this case, the Governor will be able to partially limit the number of upgrades, but will not have full control over the process.

For further information about the Smart Upgrade Governor, see 5.4, “Limiting concurrent downloads with the Smart Upgrade Governor” on page 49.

Version 6.0.5/6.5.4 and later clients not being limited by the Governor

The server that contains the Smart Upgrade database must have a matching Configuration document containing the Smart Upgrade Governor settings. This means that there must be either an individual Configuration document for that server, a group Configuration document, or a * - [Default] Configuration document. The matching Configuration document must contain the database link for that server and the Governor settings.

Each server on which a Smart Upgrade database resides must have a Configuration document specifying the Smart Upgrade settings for that server. For example, it is possible to create a link for the Smart Upgrade database on Server2 in the Configuration document for Server1, but if you do this you must also create a Configuration document for Server2 (where the Smart Upgrade database resides).

This is required so that the full Smart Upgrade configuration (including the Governor settings) will be loaded on the server where the Smart Upgrade database actually resides.

The server where the Smart Upgrade database resides may pull its configuration from either an individual Configuration document for that server, a group Configuration document, or a * - [Default] Configuration document.

If Notes 6.0.5/6.5.4 and later clients are not observing the Smart Upgrade Governor settings, it may be that the database link in an individual Configuration document points to the Smart Upgrade database on a different server, and the server that it is pointing to does not have a valid match Configuration document that contains the Smart Upgrade Governor settings.

To determine whether this is the problem:

1. Type `sucache show` at the server console of the home/mail server. If the response shows only two statistics, this indicates that a Smart Upgrade configuration has been loaded for a Smart Upgrade database on a different server (Figure B-7 on page 88).
2. At the server console of the server specified in the Server.SmartUpgrade.Database statistic (Boston/ITS0bank in Figure B-7), type `sucache show`. If the response indicates that Smart Upgrade is not configured, then Smart Upgrade Governor settings are not loaded on either server and will not be in force.

To resolve this problem, either:

- Create an individual server Configuration document, group Configuration document, or a * - [Default] Configuration document with the correct Smart Upgrade database link and Governor settings for the server where the Smart Upgrade database resides.

- or

- Replicate the Smart Upgrade database to the home/mail server and update the database link in the Configuration document to point to the replica on the same server.

### All users are being prompted to upgrade, and this is not what you expected

Using the asterisk (*) wildcard in the Source version field of the Smart Upgrade Kit document results in all Notes clients being prompted to Smart Upgrade, if the Destination version specified in the kit document is later than the current (source) version of the Notes client.

This situation will occur if no additional controls are configured to manage the Smart Upgrade process. Although this is functioning as designed, it might be an unexpected outcome if the process is not thoroughly planned before the Smart Upgrade Kit document is enabled.

If control by user group, department, location, or some other grouping is required, there are four common ways to achieve this:

- Policies

  Policies can be used to control Smart Upgrade by user, user group, or organizational unit (OU). Smart Upgrade settings can be added to a Desktop Settings document and applied using an Explicit or Organizational Policy. To control Smart Upgrade using this method, different Policies can be applied to each user, user group, or organizational unit (OU). See 5.2, “Configuring policies to assist with Smart Upgrade management” on page 38.

- Allowed Users & Servers field

  The Allowed Users & Servers field on the Administration tab of each Smart Upgrade Kit document can be used to control access to each kit by user or user group.

  **Note:** The Allowed Users & Servers field is a Readers field. If it is empty, everyone who has access to the database can access the kit document (that is, None means All). If it is filled in, only users, servers, and groups that are listed in the field will have access to the document. Remember to include any server names (or the LocalDomainServers group) to ensure that replication of the kit documents between servers is possible.

- Smart Upgrade Governor

  The Smart Upgrade Governor limits concurrent downloads by number of connections (for attached kits). It does not provide control by user, group, or organizational unit (OU). See 5.4, “Limiting concurrent downloads with the Smart Upgrade Governor” on page 49.
More specific source version settings

Pattern matching can be used in the Source version field of the Smart Upgrade Kit document to control upgrades by source version. In organizations where several different client versions are in use, this provides the administrator with the ability to control when each Notes client version will be upgraded. For further information, see 4.3, “Smart Upgrade pattern matching” on page 28.

**Important:** For Notes client versions earlier than 6.5.1, the asterisk (*) is the only accepted wildcard.
In many Lotus Notes and Domino domains, users do not have the proper operating system rights to upgrade their Notes client installations. To successfully upgrade existing Notes clients, users need Administrator rights to the OS. Previously, the only way to work around this requirement was to use a third-party application to facilitate the upgrade or elevate the user’s rights on the OS. A new feature is being developed for Lotus Notes and Domino 7 that will allow users with limited rights to the operating system to upgrade their Lotus Notes clients. This new feature is the Run as Admin utility (SURunAs). This utility enables the user to install the Notes client using different permissions than the user’s current logon provides.

Notes client users can use the SURunAs feature to upgrade to a newer Lotus Notes client release. This is designed for Notes client users who do not have Administrator privileges but who still need to update their Notes client software periodically. SURunAs can be used in Smart Upgrade or through any existing deployment method. It can be used to create a single executable file that can be attached to the Smart Upgrade Kit Document or it can be used to create a setup.exe file that can be placed on a network drive and referenced in the Smart Upgrade Kit Document.
Using the Smart Upgrade RunAs feature

You run SUSETRUNASWIZARD.EXE to create an executable file, SURUNAS.EXE, that the Notes client user can run to upgrade their Notes client (Figure C-1).

This new executable file runs within the standard Smart Upgrade feature on the local workstation, as a user with Administrator privileges. The SURUNAS.EXE file can be renamed to any file name with the.exe extension. You specify the administrator user name and password while completing the SUSetRunAs wizard (Figure C-2).

Important: The Smart Upgrade RunAs utility uses encryption to store user name, password, and command information when creating the SURUNAS.EXE.

In regard to the Administrator account that is used with SURunAs, it is recommended that a temporary Administrator account be created in the OS domain. This account would be the one referenced when running the SUSETRUNASWIZARD.EXE and would have Administrator access to all of the operating systems in the Domain. The Notes administrator would track progress of upgrades using Smart Upgrade tracking, and when the upgrade is finished the administrative account created for SURunAs should be deleted. This adds extra security because the account used to give the user’s elevated privileges will no longer be active.
Appendix C. Sneak preview: Smart Upgrade “Run As Admin” utility

While the wizard is running, specify the file, usually setup.exe or a similar file, that is to be run when the user runs SURUNAS.EXE. For more about installation kits, see Appendix A, “Understanding Smart Upgrade kits” on page 65. The setup.exe file that you specify is stored in SURUNAS.EXE, or you can specify a Universal Naming Convention (UNC) path to a shared network drive from which that setup file can be accessed (Figure C-3).

**Figure C-3** Choosing to store installation files on UNC or as attached files

In addition to specifying the setup file to be used, you also specify any other files to be included in the install kit. See Figure C-4

**Figure C-4** Choosing which files to include in the executable

The SUSetRunAs wizard creates the install kit that the Notes client end user runs to upgrade their Notes client. This kit can then be attached to the Smart Upgrade Kit document or placed on a Network Drive and referenced in the Smart Upgrade kit.

When you reference an installation kit on a network path, the SUSetRunAs wizard asks for the UNC path to the installation executable (normally setup.exe) as shown in Figure C-5 on page 94.

---

**Tip:** If you have multiple domains but you do not have a user name and password that can be used across multiple domains, run the Smart Upgrade RunAs wizard for each individual domain.

---

Check Box Specifies that setup.exe will be the file launched when SURUNAS.exe launched.
You can click **Check UNC Path** to verify that the path chosen is a valid UNC path. If the chosen path is not valid, a dialog box warning appears (Figure C-6).

The administrator is asked to provide command line parameters to be executed when SURUNAS.exe is launched, as shown in Figure C-7. The standard command line parameters used in all Notes installation packages apply to the SURunAs utility. For more about command line parameters, see 4.4, “Using optional arguments when running Smart Upgrade” on page 29.
**Important:** The MSI property ALLUSERS=1 must be passed on the command line if you are using a Webkit, Upgrade Kit, or Full Install Kit.

This must be added manually in the command line section as shown in Figure C-7.

When calling the setup.exe, for example, `/s /v"ALLUSERS=1 /qb+"` in which `/s` makes the setup.exe silent and `/v` would pass the ALLUSERS=1 and the qb+ command to the MSI installer.

When calling a Webkit, for example, `-s -a /s /v"ALLUSERS=1 /qb+"` in which `-s` makes the unpacking of the kit silent, `-a` passes the arguments to the setup.exe, `/s` makes the setup.exe silent, and `/v` passes the ALLUSERS=1 and the qb+ command to the MSI installer.

See 4.4, “Using optional arguments when running Smart Upgrade” on page 29 for more information about command line options.

The administrator is then asked for the location in which the SURUNAS.exe should be created. This would normally be a network drive or could be local to the Administrator machine if the plan is to attach the file to a Smart Upgrade Kit Document. See Figure C-8.

![Figure C-8 Dialog for the location to save SURUNAS.exe](image)

At completion of the SUSetRunAs wizard, a dialog appears showing the actions taken to create SURUNAS.exe and the results. See Figure C-9.

![Figure C-9 Dialog showing the actions taken to create SURUNAS.exe and the result](image)
When the SUSETRUNASWIZARD.exe is completed, a SUSetRunasWizard.log is created in the directory where the SURUNAS.exe was generated. This log has information about the parameters that were used to created the SURUNAS.exe. See Figure C-10.

![SUSetRunasWizard.log - Notepad](image)

**Figure C-10 SUSetRunasWizard.log**

The completed SURUNAS.exe is now configured and can launched directly by a user from a shared network drive or can be referenced in or attached to a Smart Upgrade Kit Document. For more information about using the executable in a Smart Upgrade Kit Document, see 4.5, “Creating Smart Upgrade Kit documents” on page 32.

When SURUNAS.exe is launched either by the user or through the Smart Upgrade process, there is no indication to the user that the installation is being performed through modifications that were made using the Run As Admin utility in Smart Upgrade. The installation of the Client is performed as if the user were performing the Installation, but is actually being installed using the account referenced in the SUSERunAs wizard.

This new feature enables Domino administrators to benefit from the centralized control that the Smart Upgrade feature provides in upgrading the Notes clients in their Domain. Now all users, regardless of their OS rights, can upgrade their Notes clients using the Smart Upgrade feature.
Related publications

The publication and resources listed in this section are considered particularly suitable for a more detailed discussion of the topics covered in this Redpaper.

IBM Redbooks

For information about ordering this publication, see “How to get IBM Redbooks” below. This document might be available in softcopy only.

- *Lotus Notes and Domino 7 Enterprise Upgrade Best Practices*, REDP-4120

Online resources

These Web sites are also relevant as further information sources:

- IBM Lotus knowledge base
- developerWorks Lotus sownloads

How to get IBM Redbooks

You can search for, view, or download Redbooks, Redpapers, Hints and Tips, draft publications, and Additional materials, as well as order hardcopy Redbooks or CD-ROMs, at this Web site:

[ibm.com/redbooks](http://www.ibm.com/redbooks)

Help from IBM

- IBM Support and downloads
  [ibm.com/support](http://www.ibm.com/support)
- IBM Global Services
  [ibm.com/services](http://www.ibm.com/services)
Smart Upgrade was introduced in Lotus Notes and Domino 6 to provide a way for organizations to simplify and automate the process of upgrading Lotus Notes clients. Smart Upgrade helps organizations save time and money while also providing the opportunity to quickly adopt newer client versions, enabling them to sooner benefit from the new features of each Lotus Notes release.

Since its introduction, Smart Upgrade has been widely adopted by the Lotus Notes and Domino community as the preferred method of upgrading Notes clients. Consequently, Smart Upgrade has been used successfully in a wide variety of customer configurations and implementation scenarios.

This IBM Redpaper describes the features and benefits of Smart Upgrade in Lotus Notes and Domino 7. It explains the planning and implementation tasks that are required to optimize your Smart Upgrade deployment, the integration of Smart Upgrade with clustering for failover, Policies for management, and the new Smart Upgrade Governor to limit concurrent upgrades. Smart Upgrade packages and kits are explained, and the troubleshooting section helps administrators solve configuration issues.

Utilizing Smart Upgrade will relieve administrators and support staff of the need to visit each desktop, reduce dependency on third-party tools, and reduce the total costs of upgrading. This Redpaper provides the knowledge needed for organizations to achieve these goals.